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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is a high-performance
RAW image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. Because image processing does not occur inside the camera
when a photo is taken and the photo has been recorded in the special
form of “RAW image data + Image processing conditions information at
the time of shooting”, special software is needed to view or edit the
image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“development”.

When is RAW Development done?

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP.

As a result, RAW images displayed in DPP are images whose
development processing has been completed.

With DPP, you can view, edit and print RAW images without having to be
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.
In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.

#'¢%, RAW image data

Image processing conditions information
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Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

View and organize RAW images
Real-time adjustment of a RAW image

Various image adjustments while maintaining the original image
Freely apply a Picture Style
View your image before and after adjustment in the same window

Trimming and adjusting the angle of an
image

Change image size

Correction of lens aberration
Automatic/manual dust erasure processing

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print a RAW image
View and organize JPEG and TIFF images

Real-time adjustment of JPEG and TIFF
images
Various image adjustments while maintaining the original image

Print JPEG and TIFF images

Color management compatibility
CMYK simulation for commercial printing

System Requirements

Introduction

oS Mac OS X 10.6 to 10.7
Computer | Macintosh with one of the above OS installed
CPU* Intel processor C: r(natfanl:(s:eat
RAM Minimum 1GB
Displa Resolution : 1024 x 768 or more s
piay Colors : Thousands or more opeﬁlfon
* Core2 Duo or higher is recommended
This software program is not compatible with UFS (UNIX File System)
formatted disks. Advanced
Check the Canon website for the latest system requirements, Operation
including supported OS versions.
Advanced
Supported Images oI
. L and Printing
This software supports the following image types.
Image type Extension Processing ‘
RAW images*! shot with EOS DIGITAL La;gﬁrﬂgg‘g:’s
cameras, excluding EOS DCS1 and .CR2
RAW images | EOS DCS3 TIF -
RAW images*2 shot with PowerShot .CRW Jlfggll?ﬁ:F
cameras Images
JPEG images EX|f2.2, 2.21 or 2.3-compatible JPEG JPG, JPEG
images
TIFF images | Exif-compatible TIFF images TIF, .TIFF BEIBIE
*1 Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter
and have the “.CR2” extension. Index
For information on CR2 Converter, refer to Canon’s web site.

*2

» Only models where Digital Photo Professional is listed in the “Data
Type” item in the “Specifications” section near the end of the
Camera User Guide.

* Use the dedicated CameraWindow application to download images
from a PowerShot camera to a computer. See the Software Starter
Guide for details.

* Lens aberration correction can only be used with some camera and
lens models.

» Automatic dust erasure processing and other EOS DIGITAL specific
functions cannot be used.
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Trim tam image and a<.jjust the angle of an |.mage p.38 Conversion of Images
Specify an aspect ratio that matches the size of the - 038 ) )
paper on which an image is to be printed P. Convert a RAW image to a JPEG image = p.42, p.99
Erase dust shot with the image - p.73,p.75 Edit in Photoshop = p.77, p.100 @
Erase unwanted parts of an image - p.77 Perform batch processing =p.99
Edit (adjust) a JPEG image -»p.103
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1 Basic Operation

Introduction

The basic operational flow — from how to download to your computer —

images shot with a camera to checking, editing, saving and printing a

Contents at

downloaded RAW image — is explained here. a Glance
Starting UP DPP ... 6 ic
Main Window Display .............cccooeiiiiiiiiiiiiiiciccen, 6 OpBe1tion
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_ ) Operation
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Starting up DPP

Click the Dock icon.

Digital Photo Professional

) @ *"" Click

Y 1'|'"-—- "g.a 1

DPP starts up and the main window ([Folder] window) appears.

v

Main wmdow ([Folder] window)

[@ Dignal Photo Frofevsional Fue Bockmark  Label Adpstmen  Tooh  Widew Rl W4 wmasiiaw D
[atal i .

Main Window Display

In the main window, you can use tabs to select either the [Folder]

window or the [Collection] window. The [Folder] window displays the
images in folders on your computer, while the [Collection] window (p.36)
displays images selected randomly by the user from one or more folders

and gathered together.

Unless noted otherwise, the [Folder] window will be described as the

main window from this point on.

[Folder] wmdow

. s i T

[Collection] wmdow

[ oot P Pressiaal T i vew et T T T CE L]

Introduction

—_—

Contents at
a Glance

—_—

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers

of Images
N ——

Editing
JPEGI/TIFF
Images

Reference




Downloading an Image to Your Computer

Introduction
Connect the camera and computer with the cable provided and Start up EOS Utility.
download the images saved on the memory card inserted in the camera. Select the [Tools] menu » [Start EOS Utility].
For downloading images, start up the camera software “EOS Utility” —
from DPP and use. C:r(n;tfanr:(s:eat
Start Quick check tool CHF

Select the save destination for the images. Start
Select the save destination in the folder area on the left of the 5
main window.

When creating a folder, see p.50.

800 L Start EOS Utility EE Advanced
= . A T L Operation
E I LI ARl LS - A LW N p - a3
Sync folder with EOS Utilit
Folder Collection(0) o Advanced
¥ =) MacOsx EOS Utility starts up. Image Editing
» A Applications - and Printin
¥ Temporary Items EOS Utlllty 9
X :';s”s ~YaXa) EOS Utility
Lcenon Processing
» [@E Desktop Z
» [ Documents Control Camera Accessories Large Numbers
» & Library _— of Images
& Movies
& Music
)/ 8 Starts to download images Editlng
(o JPEG/TIFF
=fy Images
¥4 Sttes Lets you select and download images 9
B [ Shared
Camera settings/Remote shooting Reference
Monitor Folder
. Index




Introduction
Connect your camera and computer and turn the
camera on.
Connect the camera and your computer with the interface cable
provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and
computer, refer to the “EOS Utility Instruction Manual” (PDF |§| You cannot start up EOS Ultility in the [Collection] window
electronic manual). (p-6, p.36).

When EOS Utility has been started up from DPP, you cannot use
the following functions.

-I\@/E Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

Contents at
a Glance

* Quick check window view (p.16) Advanced
« Trimming and adjusting the angle of an image (p.38, p.111) Operation
*Digital Lens Optimizer (p.69)
» Compositing images (p.78) Advanced
* Creating HDR (High Dynamic Range) images (p.81) Image Editing
+ Dust erasure processing (copy stamp function) and Printing
(p.-73 to p.77, p.114 to p.118)
» Batch change file names (rename function) (p.101) Processing
« Printing with shooting information (p.85) La(r)%elrﬂggggrs
* Printing a thumbnail list (contact sheet printing) (p.86)
P * Printing using Easy-PhotoPrint EX or Easy-PhotoPrint Editin
(Plug-in printing) (p.43, p.46) JPEGITIEE
* Transferring images to Photoshop (p.77) Images
E Siiteie e nlad R ke * Batch saving images (batch processing) (p.99)
R
Reference

'ﬁl Lets you select and download images
e

E Camera settings/Remote shooting

Index
u‘ Monitor Folder

i I

@@

Downloading of images begins.

The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of DPP.

The downloaded images are sorted by date into folders and

saved. 8



Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card
reader.

Load the memory card into the card reader.

Open a removable disk icon in the folder area and
move the [DCIM] folder inside to a suitable place
such as to the [Desktop].

000 Digital Photo P

[IE!
i

Folder Collection(0)
v = MacOosx
» |4 Applications
(7 Temporary Items
¥ |8 Users

¥ @ canon

P & Library
= Movies
[ & Music
» = Pictures
» (4 Public
P [ Sites
b [ 4 Shared
¥ |_ EOS_DIGITAL
» [ DCIM

The [DCIM] folder is downloaded to your computer.
All images are saved in folder units inside the [DCIM] folder.

Display the images downloaded to your computer.

In the [DCIM] folder copied to your desktop, select the folder
where the shot images are saved.

8086 Digital Photo Profession

Folder Collection(0)

v = MacOsx
» | A Applications
[F Temporary ltems
v & Users
v & canon
v [ Desktop

vi
¥ 102CANON
» | Document ts
b [& Library
= Movies

F[)

& Music
» |- Pictures

Images in the folder are displayed in the main window of DPP.

-2@/5 Checking before downloading images

By selecting the memory card folder directly in DPP, the images in the

folder are displayed in DPP and you can check the shot images.

5

Copying to your computer may take time when there is a large
number of shot images saved in the memory card.

For details on the [DCIM] folder structure and the file names of
shot images, refer to “Folder Structure and File Names in the
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).
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Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list

in the main window. You can double-click an image to open the edit
window and display the image at large size.

View Images as Thumbnails in the Main Window

L Rotate selected image
Main window ‘

[@ Dignal Fhote Professional fie (i ew Amfh  Label  ASuitmest  Tooh  Window  Melp

i e bt o g 14 s o it s || e

Click to select the image
Display thumbnails of all the images inside the
folder selected in the folder area on the left

® Images displayed with the ["® ] icon are movie files and cannot
be played back in DPP. Please use “ImageBrowser EX”, which is
compatible with EOS DIGITAL movie files.
If the message [Insufficient memory.] appears, there are too many
images in one folder. Decrease the number of images in one
folder such as by dividing them into smaller folders.

@ When aspect ratio information is attached to the shot image with the
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark Il EOS-1D Mark Il EOS
5D Mark Ill, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS REBEL
T3i/600D, the image is displayed as a trimmed image (p.38, p.111).
For a list of main window functions, see p.124.

Changing the Size of Thumbnail Images

You can change the size of the thumbnail images displayed in the main
window and display them with shooting information attached.

Select the [View] menu » desired item.

Edit in Edit image window H—
View collections HG
+ Tab
v Folder view
v Toolbar
Tool palette T
Large thumbnail #1
v Medium thumbnail 2
Small thumbnail 3
Thumbnail with information ¥4
Sort b

The display changes to the selected item.
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Enlarge and View an Image in the Edit Window

Double-click

The edit window appears.

Edit window '

Tool palette

e

[ reppee Erye— J

It may take time for the image to redraw itself.
Click the [@] in the upper left of the edit window to close the edit
window.

|§| By selecting the [View] menu » [AF Point] in the edit window, you can
display the AF points selected in the camera at the time of shooting.
However, AF points are not displayed for images whose image size
has been changed and then been converted and saved (p.42, p.134),
images for which you selected an effect other than [Shot settings] as
correction of fisheye lens distortion aberration, or images which have
had settings specified during RAW processing on the camera for
distortion correction and chromatic aberration correction.

For a list of edit window functions, see p.127.

Enlarging and Viewing a Specific Area
Double-click the area you want to enlarge.

CaaZad B P R T R s

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.

© Double-click again to revert to the full view.

® To change the display position, drag on the image or drag the
enlargement display position of the tool palette.

Tool palette enlargement display position

display position by
dragging

5@/5 To display an image in an enlargement ratio other than 100%

Select the [View] menu » [200% view] or [50% view].

|§| You can change the enlargement ratio when you double-click (p.91).

Change the enlargement

Introduction

—_—

Contents at
a Glance

—_—

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers

of Images
N ——

Editing
JPEGI/TIFF
Images

Reference




Adjusting an Image oo
You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image using the tool About the Tool Palette
palette of the edit window. You can easily restore an image to its original You can adjust images with the tool palette by switching between the
settings with the [ ]] button even if you have made the wrong [RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your C:r(‘;tfa";zeat
adjustment. Try out the various adjustments. editing requirements.
As an example, the procedure to adjust the brightness of an image is Because adjustment made with the tool palette (it undergoes automatic
explained here. development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Tool palette Therefore, there are no problems with image deterioration that arise with
. editing and you can readjust your images any number of times.
{ RAW RGB MR ALD LENS * . . . .
(s s =] Reverts the image to See _Chapter 2 onwards for more detailed information on the various Sg\éz:_\;\tci:gg
@ — the original settings functions of the tool palette.
|White balance adjustment | = l| Drag the Slider Ieft or
e right . Advanced
Regiter. About Recipes Image Editing
Aetsmtng (e In DPP, all the adjustment contents (image processing conditions and Printing
information) made with the tool palette is saved to an image as data -
Picture Style E=3 “ [ ] rOCESSing
| D called a “Recipe” (p.96). Large Numbers
Standard -Y] Browse... | of |mages
Editing
JPEG/TIFF
Images
T A
Contrast: (i)} —.-.-.-.‘9.-.-.-.-
Highlight: () —— Reference
Shadow: e
| Linear
Color tone: {0} T@T
Color saturation: ()] ‘-._._._:e.—.-.-.-
Unsharp mask .:] Index
Strength: ()] m
Fineness: {0 m
Threshold: (0 m

The image brightness changes in real time according to the @ @
amount of adjustments.

-

The tool palette does not display

Select the [View] menu » [Tool palette]. @ For a list of tool palette functions, see p.128. 1



Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

Close window HEW
[ save %S
Save As... i 35
Convert and save... ®D
Page setup... {r 3P
Print... 3P
Print with detailed setting... 3D
Contact Sheet Prints... ~ 3P
Plug-in printing [
Info... |

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method, see
Chapter 2 onwards.

Save (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.23)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

Convert and save (p.42)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process (p.99)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

* Option available in the main window.
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

Close window HEW
Save £S5
Save As... i3S
Convert and save... ®D
Page setup,.. it IEP
[ Princ.. 3P )
Print with detailed setting... 143D
Contact Sheet Prints... ~3EP
Plug-in printing [
Info... |

The [Print] dialog box appears.

Print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.
Printing begins.

-Z\@/i- To change the paper size

To set the paper size etc., select the [File] menu » [Page setup].

Printing
With DPP, you can perform the following types of printing according to
your requirements. For detailed information on each printing method,
see Chapter 2 onwards.

Print one image (p.49)

Print using a Canon inkjet printer (p.43, p.46)

Print with a high-end Canon printer (p.87)

Print with shooting information (p.85)

Printing a thumbnail list (contact sheet printing) (p.86)

Quitting DPP

In the main window, select the [Digital Photo
Professional] menu » [Quit Digital Photo

Professional].

Digital Photo Professional

About Digital Photo Professional

Preferences... 3,
Service >
Hide Digital Photo Professional 3H
Hide Others H#H

[ Quit Digital Photo Professional EEQ)

DPP quits.

|§| A confirmation dialog box for saving the images appears when you
try to quit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images

adjusted.
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D Advanced Operation

A more advanced operation — from efficiently checking images, to
various ways of editing an image, printing a RAW image using a Canon
printer and sorting images — is explained here.

Efficiently Checking/Sorting Images.........cc.c............ 16
Sorting IMages........uuueeiieeieeeeeeeeeeeeeeeeeeeeeeeeeeeeee 18
Attaching Check Marks.........cccccccoeeeiiieeiiiiinieeenne... 18
Setting Ratings ......ccoovveiiiiiiiiieeeeeeeeeee, 18
Sorting Images in the Main Window ..............c........... 19
Attaching Check Marks in the Main Window ......... 19
Setting Ratings in the Main Window ...................... 19
Arranging Images in the Main Window...................... 20
Arranging by TYPE ....uuuuiiiiiiiieiie e 20
Arranging Freely .......ccoooovvoiiiiiiiiieeeeeee 21
Displaying a RAW Image and JPEG Image as a Single
IMAGE ... oo 22
Improving the Quality of an Image in the Main Window ... 23
Checking Image Information................cccccovvvveeennn. 23
Editingan Image ..., 25
About the RAW Tool Palette..........ccccceeeeeeeeeeeeeennnnin. 25
Editing with the Tool Palette in the Main Window.. 25
Adjusting Brightness...........ccoooiiiiiiiiiiiiiiiieeeeeeeeeeee, 26
Changing a Picture Style ..........cccccccooeeeeiiiiiiiieeeee. 26
Picture Style File..........ocooiiiiiiiiiiiieeeeeeee 27
Adjusting Color Tone by Changing White Balance.... 27
Adjusting Color Tone Using Click White Balance...... 28
Adjusting Contrast ..........ccccoiiiiiiiiiiieee e 29
Changing Color Tone and Color Saturation............... 29
Adjusting Monochrome ..........ccccccoiiiiiiiiiiiiieee . 30
Adjusting Image Sharpness...........cccccccviiieiieeeneeenn, 31

Detailed Setting of Image Sharpness..................... 32
Automatically Adjusting Brightness and Color (Tone
Curve AsSist) ... 33

Editing Efficiently ... 34
Editing in the Edit Image Window...............ccvvvveeee.... 34
Changing the Thumbnail Display Position to a Horizontal
POSItION ... 36
Gathering and Editing Images in the Collection Window ... 36

Trimming and Adjusting the Angle of an Image....... 38

Applying Adjustment Contents to Other Images...... 41

Saving Editing Results............cccccoiiiiiiiii 41
Saving Editing Contents to a RAW Image................... 41
Saving as a JPEG or TIFF Image.........cccccveeeeeeeeennn. 42

Re-Editingan Image........cccccoovviiiiiiiieeee 43

Printingan Image ... 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint EX ......................... 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint...................c........... 46
Printing Photographs with a Printer other than Canon
Inkjet Printers..........cccoooiiiiiieee e 49

Organizing IMages .......ccceeeieiieeiiee e 49
Deleting an Unwanted Image ..............occcociiiieeennnn.n. 49
Creating a Folder for Saving Images..............ccc........ 50
MOVING IMAQES .....oeeeeiiiieeee e 50
Moving Images in Folders ...........oovviiiiiiiiiiiieeeeees 51
Registering Frequent-Use Folders (Bookmark
Registration) .........cccccooeiiiiiii e 51

Organizing Bookmarks ..........cccoevvviiiiiiieeeeeeiiinn. 51
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window Double-click the area you want to enlarge.
and efficiently check each image. You can attach check marks and sort s

Introduction
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images into five groups.

Contents at

. . . a Glance
Display the quick check window. — Double-click -
Click the [Quick check] button. '
Digital Photo Professional - [ MacOSX /Users/canon /Pig BaSig
Operation

The quick check window appears.

Click the [Next] or [Previous] button to switch
between images to be checked.
Quick check window

.....

[

All the images displayed in the main window can be checked in

the quick check window.

The area you double-clicked is enlarged to 50% view.
To change the display position, drag on the image.
Double-click again to revert to the full view.

2 To quit, click the [OK] button.

@ When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF points
are not displayed for images which have had their image size
changed and then been converted and saved (p.42, p.134), which
have had settings specified during RAW processing on the camera
for distortion correction and chromatic aberration correction, which
are composited, or which are created as HDR (High Dynamic
Range) images.
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> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switch between images using the keyboard

You can also switch between images by pressing the <38> + <—>or
<3E> + <> keys.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

The enlargement ratio when an image is enlarged is half (50%) of
the 100% (actual pixel size).

You can change the enlargement ratio to 100%, when an image is
enlarged (p.91).

For a list of quick check window functions, see p.132.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ %] marks) for each subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [%] to [5].

Check mark

[ Clear }

12345 Click

The selected check mark appears in the upper left of the window.

C‘Jheck mark

2/15 IMG_0002.CR2 [3456 x 2304]

| soxview [N Full screen
e l__._.,_,_,._J

Check mark

Click the [Clear] button to remove the check mark.

|§| The values of check marks attached to images in DPP version 3.8
or earlier are maintained as they are.
You can also attach check marks from the menu that appears by
clicking on an image in the main window while holding down the
<control> key.

Setting Ratings
Display the image you want to rate, and then click
any one of the [ - ].

Rating
T

(s = 2 & ») Click (changes to [ % ] after

clicking[ = ])

The rating is set and an icon corresponding to the selected [ ]
appears in the upper left of the window.
(Window shown with a rating of three [%])

® To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.

Il?ating icon

2/15 IMG_OD02.CR2 [3456 x 2304]

Check mark

123

P
| soxview [ Full sereen
R i

To cancel the rating, click the same [ ] as when the setting was
made on the right of the window.

® As the file structure of the image data is changed when a rating is
set to an image, it may not be possible to check the image
information in third-party software.

|§| You can also set ratings (including [Reject] setting) from the menu
that appears by clicking on an image in the main window while
holding down the <control> key.
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Introduction

Sorting Images in the Main Window Setting Ratings in the Main Window S
You can also sort images in the main window by attaching check marks Select the images you want to rate, and then click
or setting ratings (indicated with [£] marks) for each subject or theme. any of the [@a] in the toolbar. C:fgfa"r:zeat
Attaching Check Marks in the Main Window _ e
Click (changes to [E1] Operation

Select the images you want to attach a check mark
to, and then click any of [El] to [E] in the toolbar.

after clicking [H])

—L— Select Advaficed
e Opegiation

= i WG_0004.CR2 i
| - - = Advanced
The rating is set and an icon corresponding to the selected [£4] Image Editing
; . and Printing
appears in the image frame.
(Window shown with a rating of three [Ei] as an example)
Processing
Large Numbers
of Images
N ——
Editing
frame. JPEGITIFF
Images
Reference
Check mark i = @ Rating icon
| MG 0002 CR2 CWCOUSCRE % mm INC0004CR2 = —
To cancel the rating, click the same [E1] as when the setting was
made in the toolbar. Index
[Reject] cannot be set with the toolbar. Set [Reject] with the -
[Label] menu or the quick check window (p.18).
Click the check mark in the toolbar again to remove the check @ @
marks.



Y

=@> To select multiple images in the main window

Click on desired images while holding down the < 38> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <shift> key.

-Z\@/i- To display more thumbnails in the main window

You can display a large number of images by setting the size of
thumbnail images to small (p.10). Then, by selecting the [View] menu »
[Rating] and removing check marks so that ratings no longer appear in
the image frame, you can display still more thumbnail images in the main
window.

|§| The [Label] menu can also be used to attach check marks and set
ratings.

By selecting the [Edit] menu » [Check mark] or [Rating] » image

selection criteria, you can refine criteria for selecting

checkmarked or rated images.

You can display and change the rating settings set in DPP with

other bundled software and on an EOS-1D X, EOS 5D Mark IlI,

EOS 7D (firmware version 2.0.0 or later), EOS 60D, EOS REBEL

T4i/650D, EOS REBEL T3i/600D, or EOS REBEL T3/1100D

camera.

» EOS Utility version 2.9 or later:

Ratings set in DPP are displayed. However, [Reject] is not
displayed and you cannot change rating settings.

* On an EOS-1D X, EOS 5D Mark Ill, EOS 7D (firmware version
2.0.0 or later), EOS 60D, EOS REBEL T4i/650D, EOS REBEL
T3i/600D, or EOS REBEL T3/1100D camera:

Ratings set in DPP are displayed in the playback screen. You
can also change rating settings. However, you cannot display or
change settings for [Reject].

Reversely, you can also display and change with DPP the rating

settings set for stillimages on an EOS-1D X, EOS 5D Mark I,

EOS 7D (firmware version 2.0.0 or later), EOS 60D, EOS REBEL

T4i/650D, EOS REBEL T3i/600D, or EOS REBEL T3/1100D

camera.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [View] menu » [Sort] » desired item.

View collections NHEG
v Tab
v Folder view
+ Toolbar
Tool palette ®T
v Rating
Large thumbnail #1
¥ Medium thumbnail 382
Small thumbnail ##3
Thumbnail with information 384

o Rating : Ascending order
Rating : Descending order

v File name
Shooting Date/Time
RAW priority

Check mark1
Check mark2
Check mark3
Check mark4
Check mark5

The images are arranged in the order according to the selected
item.
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Sort item

Rating: ascending
order

Rating: descending
order

File name

Shooting Date/Time

RAW priority

Check mark1 -
Check mark5

Description

Sorted in order of fewest [ ].

Sorted in order of most [« ].

Images are sorted by file name in alphanumeric
order (0to 9 » Ato 2).

Images are sorted by shooting date and time
from the earliest.

Images are sorted in the following order: RAW
images - JPEG images - TIFF images.

Images with check marks take priority and are
sorted in number order.

-Z@/E Check mark sorting order

When check marks from 1 to 5 have been set, the images are sorted as

follows:

Check mark1 selected: 122->3->4-5
Check mark2 selected: 2-3—->4->5->1
Check mark3 selected: 3-4->5->1->2
Check mark4 selected: 4»5->1->2-3
Check mark5 selected: 5>1-»>2->3->4

Arranging Freely

Drag and drop the image to the desired location.

( Dignal Fhats Profesasnal Fie  [d  view T T e P — - — O )
ann ]

e S s e Rt o e 1 s o it e | e

The image moves to the desired location.

You can also select multiple images (p.20) and move them.

The order of rearranged images is maintained until you quit DPP
or select another folder in the folder area.

Select the [View] menu » [Sort] P [File name] to revert to the
order before the images were rearranged.

E\@/E Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you quit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in the [Preferences] to
maintain the order of images without changing the image file names
(p.91).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.101).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Digital Photo Professional] menu »
[Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

e

Preferences

- General sertings || View sertings | Tool palerte | Color management -
——

Grid pitch
64 Pixels(8-256)

Locking selected image
E Images opened in Edit window remain selected in main window

Magpnification in Edit window

@) Fit to window ) 50% ) 100% ) 200%

Magnification when the Edit/Edit image window is double-clicked

@ 50% ) 100% O 200%

and IPEC
E Display only CR2 images for CRZ and JPEG files of the same name J

Sort order in main window
E Retain sart order

Highlight/shadow warning

Highlight 255 (192-255 (N
Shadow 0 (0-64) F—
Quick check tool display
@ s0% () 100% (moiré reduction off)
( Cancel | f OK )

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [(GZXB] mark (p.126).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

-Z\@/E When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.49)

* Moving or copying an image (p.50)

» Checkmarks (p.18, p.19)

* Rating (p.18, p.19)

» Rotating an image (p.124, p.132, p.133)

» Attaching a thumbnail to an image and saving (p.23)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[ 23] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2 (p.125).

@ In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00

22




Improving the Quality of an Image in the Main Window
Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].

Open in Edit window FO
Open in Edit window (enlarged)

Close all

Open window N
Close window HEW
Save #5
Save As {1 38

( Add thumbnail to image and save 3T ]

Convert and save... #D
Batch process... #B
Create new folder... 1+ 38N
Page setup... {+ 8P
Print... 3P
Print with detailed setting... {+3#D
Contact Sheet Prints... ~HP
Plug-in printing [ 2
Add to collection #G
Remave fram collection T+ 3#G

-:\@/3 The extent of the improvement in quality

The quality is improved for any JPEG or TIFF image. While the image
quality improves regardless of the thumbnail size (p.10), selecting [Large
thumbnail], with its larger display size, shows the improvement more
clearly than [Medium thumbnail] and [Small thumbnail].

@ A large number of images may take some time to add.

Checking Image Information

Select the image for which you want to check the
image information.

Click the [Info] button.
800

il
(] '

Folder Collection{0)
v & ENG
P | % Applications
» [ Developer
» [ Phora £

The image information window appears (p.24).
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Select a tab sheet and check information.
[Shooting Information] tab sheet

[Metadata] tab sheet

800

_ IMG_0001.CR2

{ Shooting Information | M

1

Aata

| Item

Camera Model
Firmware

Shooting Date/Time
Owner's Name
Shooting Mode

Tw( Shutter Speed )
Av( Aperture Value )
Metering Mode
Exposure Compensation
ISO Speed

Auto 150 Speed
Lens

Focal Length

Image Size

Image Quality

Flash

FE lock

White Balance Mode
AF Mode

Picture Style
Sharpness

Contrast

Saturation

Color tone

Color Space

Highlight tone pricrity
Aute Lighting Optimizer

Dust Delete Data
File Size

Drive Mode

Live View Shooting
Date/Time(UTC)
Latitude

Lonnitude

Long exposure noise red...
High IS0 speed noise re...

Peripheral illumination c...

Value

FileName ___________|IMG000LCR2 I

Canon EOQS XXXX
Firmware Version X.X.X
TR TR b R

Shutter-Pricrity AE
1/1600

8.0

Evaluative Metering

1]

400

OFF

EF70-200mm f/4L USM
188.0mm

prteseeied

Auto

Manual focusing
Landscape

4

1]

1]

1]

sRGB

0:0ff
0:5tandard
0:Disable
3:Disable
Disable

No

KAHKKB
Continuous shooting
OFF

r R

800 _ IMG_DD01.CR2

{ Shooting Information | M

Description a

[Document Title]
XXANKKAX

[Author]
XXANKKAX

[Author Title]
XXANKKAXK

[Description]
XXANKKAXK

[Description Writer]
XOXXNXK

[Keywords]
XXAXKHAXK

[Copyright Status]
XOKXXNXK

[Copyright Motice]
XXAXKHAX

[Copyright info URL]
XXANKKAX

Shooting information is displayed in the [Shooting Information]
tab sheet, while IPTC* information appended to the image after
shooting is displayed in the [Metadata] tab sheet.

IPTC* information provides additional comments on images,
such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the [Metadata]
tab sheet.

IPTC* information can only be appended to JPEG/TIFF images
using Photoshop (CS3 or later).

* International Press Telecommunications Council (IPTC)

The contents of the [Shooting Information] tab sheet will vary
depending on the camera model.

Y
~
NS

Convenient uses in the main window

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in [View]
menu » [Thumbnail with information] (p.10).
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the []

button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and

how to adjust automatically with the [RGB] tool palette are explained in
this section.

Edit window

Tool palette

] = wC

| — =]
e

el

— —— J

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <3f> +
<Z> keys.

|§| You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the image before and
after adjustment (p.53).
You can synchronize multiple images and edit while comparing
them (p.54).

See p.127 for a list of edit window functions, and p.128 for a list of
tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your
editing requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/ALO] and [LENS] tool palette are explained in
Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tool palette] button (p.124) in the toolbar on the main
window, the same tool palette that appears in the edit window is
displayed and you can edit images.
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Adjusting Brightness

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

= Reverts the image to
A alg st [ ® ) the original settings
S R l( ﬂ-ﬂﬂwj Enter a numerical
|While balance adjustment (2] value
1| 2] 3 |( Register..
Shot settings B Tune.. )

Drag the slider left or right

|§| The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when
entering a value).

Changing a Picture Style

If the image you shot is different to what you visualized, you can change
the Picture Style to get closer to what you envisaged.

Even if you have saved the image (p.41) with [Monochrome] (p.30)
selected, you can still change to another Picture Style at any point by
simply selecting a Picture Style other than [Monochrome].

[Ficture Styte (=] ;l Reverts the image to
[ — 4}]( e the original settings
Select

% 4

A

h—ll]_ﬂ =30 -6.0 =40 -20 0 20 40

Contrast: i
Highlight: sy s
Shadow: o |||||i|||||

|§| Even if the RAW image is from a camera that does not have
Picture Style settings, you can still set a Picture Style as long as
the RAW image is compatible with DPP (p.3).
You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style (p.92).
[Auto] is only applied to images shot with the EOS-1D X, EOS 5D
Mark 11, EOS REBEL T4i/650D or EOS REBEL T3i/600D.
When changing a Picture Style with several images selected, you
can select [Auto] if images shot with the EOS-1D X, EOS 5D
Mark 11, EOS REBEL T4i/650D or EOS REBEL T3i/600D are
included. However, [Auto] is actually applied only to images shot
with the EOS-1D X, EOS 5D Mark Ill, EOS REBEL T4i/650D or
EOS REBEL T3i/600D.
You cannot select [Auto] with multiple-exposure RAW images
created on the camera.
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Picture Style Description

Standard The image looks vivid.

Ordinarily, this setting is suitable for most images.

The color tone will be adjusted to suit the scene.
The colors will look vivid, especially for blue skies,
greenery, and sunsets in nature, outdoor, and
sunset scenes.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.29).

For vivid blues and greens.
Effective for making images of landscapes
impressive.

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.30).

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP
is displayed in [].

Auto

Portrait

Landscape

Neutral

Faithful

Monochrome

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

Picture Style File

A Picture Style file is an extended function file of Picture Style. See p.59
for how to use Picture Style files.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an
image of, for example, pale-colored flowers.

{ RAW | RGB NR/ALO LENS |

‘Erightness adjustment | ‘
;|:.;;::|..:\_(;';|:.;|::|.. 0.00
‘White balance adjustment l o] } Reverts the image to

7] T ; the original settings

2 | 3 Register
-¢]): Tune.. |

[ Shot settings

Select

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.28).

Y
~Q= Tune with color tone

To make further fine adjustments to color tone after adjusting the white
balance, you can use [Color tone] (p.29) to get closer to your
requirements.

® You cannot register the adjustment results as personal white
balance (p.98) when you have selected [Shot settings] from the
list box.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

@ Refer to your camera’s Instruction Manual for details on each white
balance setting.
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

| RAW | RGB NR/ALO LENS |
|Erighrness adjustment = |
|||||||||||m||||||||||| G-DD
White balance adjustment = |
E P ]z | - e .
- ' = Click
Shot settings I-.—} ( Tune... :I

Click on a point that is to be the standard for white.

Reverts the
The coordinates of the cursor position and the image to the
RGB values (8-bit conversion) original settings

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, click the [] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast

weaker.

| Picture Styla

|
(= | Reverts the image to

Standard

i:]( Browse...

W

g

A

Cantrast:
Highlight:
Shadow:

! Linear
Color tone:

Color saturation:

100 “3.0 -6.0 -4.0

=2.0 [u] 20 4.0
{(¥]] RN SRR
et e

o ||||i||||
10) ||||i||||

Unsharp mask

)

Strength:
Fineness:

Threshold:

o i||||||||||
o i||||||||||

the original settings

- Drag the slider left or
right (9 steps)

o i||||||||||

A/
~ N
/@\

Displays the value of the setting

[Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing
software that has advanced editing functions. Note that when [Linear] is
checkmarked, the image will become dim.

|§| The Auto Lighting Optimizer (p.61) will not function when [Linear] is

checkmarked.

Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.26) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (p.30).

| Picture Style

(=]

Standard

i¢]|" Browse... |

I

4

A

Color saturation:

100 8.0 -60 -40 -20 0 20 40

Contrast: AWy .\:(. i

Highlight: | L ,5. i

Shadow: s v s
| Linear

Color tone: )

{0)

Unsharp mask

.:]”I

— Reverts the image to
the original settings

T Drag the sliders

left or right

Strength: o $||||||||||
Fineness: 0 i||||||||||
Threshold: o i||||||||||
Displays the values of the settings
Color tone:

Color saturation:

Mainly used for adjusting skin tones. Move the
slider to the right to make skin tones more

yellow, and to th
redder.

e left to make skin tones

The overall color depth of the image is

adjusted with co

lor saturation. Move the slider

to the right to make the color deeper, and to
the left to make the color weaker.

@ The adjustment range is —4 to +4 (in 1-stop increments).
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Adjusting Monochrome

When the Picture Style (p.26) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box.

|Picture Style [i B |

e

Monochrome | $] (" Browse... ‘1

5 g

A

h—lD_O -8.0 -6.0 -40 -20 0 2.0 4.0

—— Reverts the image to
the original settings

Cantrast: o] '—u—u—.-.eu—u—.-.‘
Highlight: [ B s
Shadow: L e e
! Linear
Filter effect: {None)| e e
Toning effect: (Nong) )
Unsharp mask | :]
Strength: (] m
Fineness: ] m
Threshald: {0} m

Drag the sliders
left or right

Displays the values of the settings

Filter effect: Creates an image where the white of clouds and the

Filter

None

Yellow

Orange

Red

Green

green of trees are emphasized in the same
monochrome photograph.

Example of effect
Ordinary monochrome image without filter effect.

Blue sky is reproduced more naturally and white
clouds emerge clearly.

Blue sky becomes somewhat darker. The
brightness of the setting sun increases further.

Blue sky becomes quite dark. Autumn leaves
become clear and bright.

Human skin tones and lips become softer. The
green leaves of trees become clear and bright.

Toning effect: You can create a monochrome photograph to which a

Y
N

single color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

=)= Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider closer to the right.
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Adjusting Image Sharpness

You can make the overall atmosphere of an image harder or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and

[Unsharp mask].

[Sharpness]:

Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting), the more the edges are
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.

[Strength]:

[Fineness]:

[Threshold]:

Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting), the more the image’s edges are
emphasized for a sharper image.

Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the more fine detail can be emphasized.
Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

Select [Sharpness] from the list box and make the

setting.

‘ Picture Style

[E:_N— Reverts the image to

Standard

i:_]li Browse... |

the original settings

s

e

A

100 -3.0 -60 -40 -20

0 20 4.0
Contrast: Ao
Highlight: ) o ,5. e
Shadow: 10 F._.T.-'.Q_._..-.q
! Linear
Color tone: 1o T@T
Color saturation: 10) —._._.-.e._._.-.-
([ sharpress ) Select [Sharpness]
Sharpnass: bl s

brag the slider left or right

Displays the value of the setting

@ The adjustment range is 0 to 10 (in 1-stop increments).
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. . Introducti
Detailed Setting of Image Sharpness Arocietion

Select [Unsharp mask] from the list box and make

the setting. Contents at

a Glance
| Picture Style |3J| \ )
: Standard f #] ( Browse... ij Basic
' Operation

Advanced
K i et : i (0]] ion
-10.0 -80 -6.0 -40 =20 O 20 4.0

Contrast: [ ety .$. Ve

Highlight: ([0 sannionn.~ s Advanced
e e - s Image Editing
S a"l:l_n:wunear {U] LT T T B O B and Printing
Color tone: ()] T@T
Color saturation: 10 T@T Processing
( unsharp mask 141) Select [Unsharp mask] Large Numbers
of Images
Strength: :
Fineness: _.‘ o
Threshold: o Edltmg
! JPEG/TIFF
Images
Displays the values Drag the slider left or right
of the settings
Reference
—_—
Index

? The effects of sharpness adjustment appear unnatural @

Adjust image sharpness with the window view set to [200% view],
[100% view] or [50% view]. If the view is set to [Fit to window] (full view),
the effects of adjustment may seem unnatural. 32



Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.143). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired
automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

|} NRSALO LENS *
I ] + t—— Reverts the tone curve
Tone curve adjustment ( | to the original settings
'''''' RG]« [ c ¢ |
255 A High
Standard
D ol
0 255
Eﬂghtﬂﬁss trrrrrerrfrrrrn et Dz
Contrast: "““‘@"““ e
Hue ey erenn |‘-?-—'! DE
Saturar“]n ety reny |bi lDD 3
Sharpness: e—ibl 0 ?

The tone curve changes as adjusted.

|
\\/

== Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

* Images which have extreme backlighting

(D Ifyou click the [(E25]] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.107).
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Editing Efficiently
Editing in the Edit Image Window

The thumbnail display and the edit window are combined and images can
be edited efficiently while quickly switching between images to be edited.
Images to be edited are selected beforehand in the main window.

In the main window, select the images you want to edit.

Switch to the edit image window.
08006

Folder Collection(()
5 ENG
A Applications
I Lk Developer
[E phorn i

Click

v w w

The main window switches to the edit image window.

Edit the image.
Change the size
Edit image window

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

It may take time for the image to redraw itself.

The same tool palette as in the edit window is displayed and you
can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <38> +
<Z> keys.

@ By selecting the [View] menu » [AF Point] in the edit window or edit
image window, you can display the AF points selected in the camera
at the time of shooting. However, AF points are not displayed for
images whose image size has been changed and then been
converted and saved (p.42, p.134), images for which you selected
an effect other than [Shot settings] as correction of fisheye lens
distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction and
chromatic aberration correction.
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Double-click the area you want to enlarge.

Double-
click

o i i b b o i

The area you double-clicked is enlarged to 100% (actual pixel
size).

To change the display position, drag on the image or drag the
enlargement display position (p.128) of the tool palette.
Double-click again to revert to the full view ([Fit to window]).

To return to the main window, click the [Main Window] button on
the toolbar.

-I@/E To display an image in an enlargement ratio other than 100%

Click the [50% view] or [200% view] on the toolbar.

5

You can change the way the tool palette is displayed (p.92).

You can change the enlargement ratio when you double-click
(p.91).

With the edit image window, you can only select images from one
folder. To gather images from several folders for editing, see
“Gathering and Editing Images in the Collection Window” (p.36).
For a list of edit image window functions, see p.133.
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Changing the Thumbnail Display Position to a Horizontal Position

Select the [View] menu » [Change thumbnail
position].

ot v i o o e aa —

If you select [Change thumbnail position] again, the thumbnail
display reverts to the vertical position.

Gathering and Editing Images in the Collection Window

You can gather any randomly selected images together in the
[Collection] window for viewing, comparison and editing. You can gather
images from several folders as well as from only one folder, allowing you
to work with them efficiently.

Select images from the [Folder] window in the main

window, and select the [File] menu » [Add to collection].

Open in Edit window *O
Open in Edit window (enlarged)

Close all

Opéenwindow #EN
Close window HwW
Save #S
Save As... {35
Add thumbnail to image and save {#T
Convert and save... ®D
Batch process... #B
Create new folder... {1+ 3N
Page setup... {+ 3P
Print... 3P
Print with detailed setting... 3D
Contact Sheet Prints... ~¥P
Plug-in printing »

( Add to collection #G ]

Remave from collection 3G

The selected images are added to the [Collection] window and the
number of selected images is shown on the [Collection] tab sheet.
When you add RAW and JPEG images displayed as a single
image (p.22), the number of images shown on the [Collection]
tab sheet increases by 2.

You can select several images and add them to the [Collection]
window.

You can also add images to the [Collection] window by selecting
images, clicking on the image while holding down the <control>
key, and selecting [Add to collection] from the menu that appears.
You can add up to 1,000 images to the [Collection] window.
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Select the [Collection] tab sheet.

8006
2 @ &
Folder Collection(14)
v = MacDsx

b | & Applications

[ ¥ Temporary Items
¥ |& Users

v @ canon

The selected images are displayed in the [Collection] window.

Check displayed images in the [Collection] window.

@ Digital Phate Professional File Edit  View Bookmark  Label  Adjustment  Tools Window Help
ann Digital Photo Professional - [Collection]

Adbe RGE | Adabe REX High qualty  Recipe data Ne Brumiber of images 7

Humber of velected images: 0 L

4 wed 46 AM B

Edit the images.
You can now edit the images displayed in the [Collection]
window.
Images displayed in the [Collection] window are retained in the
[Collection] window even after exiting DPP.

|
\\/

:@5 To remove images from the [Collection] window

Removing randomly selected images
Select the images to be removed in the [Collection] window and then
select [Remove from collection] in the [File] menu. (You can also remove
images from the [Collection] window by selecting the images, clicking on
the image while holding down the <control> key, and selecting [Remove
from collection] from the menu that appears.)
Note that even if you remove an image from the [Collection] window, the
original image remains unaffected.

Removing all images
Select [Clear collection] in the [File] menu. (You can also remove all
images from the [Collection] window by clicking while holding down the
<control> key, and selecting [Clear collection] from the menu that
appears.)
Note that even if you remove all images from the [Collection] window,
the original images remain unaffected.

® Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window are
all applied to the original image.

ﬁl You can arrange images displayed in the [Collection] window the
same way as in the [Folder] window (p.20, p.21). You can
maintain the order of rearranged images even after quitting DPP
by checkmarking [Retain sort order] on the [View settings] tab
sheet in the [Preferences] (p.91).
You cannot use the following functions in the [Collection] window.
« Starting of EOS Utility (p.7), or synchronizing of folders with

EOS Utility

» Batch change the file name of images (p.101)
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Trimming and Adjusting the Angle of an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before trimming. If
you select [Circle] for [Aspect ratio], the area outside the specified range

Introduction

Adjust the angle of the image as needed.
Trimming/angle adjustment window

# 1/1 IMG_DO01.CRZ [3456 x 2304]

—_—

Contents at

image, the image will be trimmed at the largest possible trimming
range.

|§| When aspect ratio information is attached to an image shot with the
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark lll,
EOS 5D Mark lll, EOS 7D, EOS 60D, EOS REBEL T4i/650D or
EOS REBEL T3i/600D, the trimming range based on the aspect
ratio information is displayed.

is only masked in black and the image will not be cropped. Largest a Glance
------------------------------------------- possible
Select the image to be trimmed. trimming Basic
range Operation
Open the trimming/angle adjustment window. Click
Click the [Trimming Angle] button. (rotate
— : : image left Ad%ed
Digital Photo Professional - [ MacOSX /Users/canon/Pic or rlght in Op ion
= __ = _ 90-degree
: “'\.% f@ "x& x@ @ increments)
Rotate feft Rotare right Ok Stamp Trimming Batch Advanced
- - Image Editing
""" o~ U i and Printing
Drag® (0.01-degree increments;
" adjustment range: -45 to +45 degrees) P .
: rocessing
R - Large Numbers
- — ' Use the mouse (click A/V) to adjust the angle or of Images
The trimming/angle adjustment window appears. directly enter the adjustment angle* (0.01-degree —
Editing can be done once the image is displayed clearly in the increments; adjustable range: -45 to +45 degrees) Editing
trimming/angle adjustment window. * You cannot adjust the angle of images that exceed 9999 x 6666 JFI'EG/T'FF
. L mages
pixels in size.
If you click [Center on Screen], you can display the trimming
range in the center of the window. Reference
When correcting lens aberrations, it is recommended to perform
lens aberration correction before adjusting the angle of the
image. Index
If you click the [OK] button after adjusting only the angle of the




Select a ratio and drag the trimming range.

anm = 171 IMC_0001.CR2 [3456 x 2304]

Cancel

Select a
trimming
ratio

Drag the
trimming
range

AT 362} -> {220, IAAD § = (577 % BOSA 1| 150 v

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range. (Not available
when [Circle] is selected.)

List of aspect ratios (width : height)

1:1

3:2

2:3

4:3

3:4

5:4

4:5

A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

Circle

[Free]: You can trim an image to any size, regardless of the

selectable ratio.
[Custom]: You can trim an image at the specified ratio.
[Circle]: The area outside the specified range is masked in
black. The image is not trimmed.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.126).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.43).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.126).

+ Edit window: The image is displayed in its trimmed condition.

+ Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.42).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D X, EOS-1D Mark 1V, EOS-1Ds Mark 111, EOS-1D Mark I,
EOS 5D Mark Ill, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS
REBEL T3i/600D, the set trimming range based on the aspect ratio
information is displayed. Since the image is not actually trimmed, you
can change the trimming range or revert to the condition before
trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 5D Mark Ill, EOS 60D, EOS REBEL T4i/650D
or EOS REBEL T3i/600D, its trimming range cannot be changed nor
reverted to the condition before trimming, since the image is actually
trimmed and saved in the set trimming ratio.”

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.135).

* When shooting with EOS 5D Mark Il and [Add cropping information]
is set in Custom Functions, aspect ratio information is only set and
the image is not actually trimmed, even for JPEG images.

ALy

> Convenient functions of the trimming/angle adjustment
window

Ay

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <38 > key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <shift> key.

© For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

|§| For a list of the trimming/angle adjustment window functions, see
p.135.
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Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]
menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu » [Paste recipe to
selected image].

The recipe is applied to the image.

|§| The recipe (p.96) can be saved as a separate file from the image
and loaded and applied to another image (p.97).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.38) range information can be saved to a RAW image or to a
separate RAW image.

The adjustments made with the tool palette (p.56 to p.68) and the dust
erase processing explained in Chapter 3 (p.73 to p.77) can also be
saved in a RAW image.

Select the [File] menu » desired item.

Open in Edit window ¥0
Open in Edit window (enlarged)

Closeall

dpen window EIN
Close window EW
Save 3ES

Save As. .. {+3S

Add thumbnail to image and save {r3T
Convert and save... #D
Batch process... 3#B

Create new folder... 138N
Page setup... {+ 3P

Print... 3P

Print with detailed setting... 3D
Contact Sheet Prints... ~¥P

Plug-in printing »
Add to collection £

Remave from collection 4 #G

Clear collection

Delete 3 <&
Info... 4|

Your adjustments are saved to the image.
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Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

The image is saved as a separate image, so the RAW image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

Open in Edit window #0
Open in Edit window (enlarged)
Close all
Close window HEW
Save 35
Save As... {+ 385
' Convert and save... ®D l
Batch process... #*B
Create new folder... 13N
Page setup... {r 3P
Print... P
Print with detailed setting... {+3D
Contact Sheet Prints... ~¥P
Plug-in printing [ 3
Add to collection *G
Remave fram collection 138G
Clear collection
Delete <=
Info... 4|

The [Convert and save] window appears.

Specify the necessary settings, and then click the
[Save] button.
By default, the image is converted and saved to a JPEG image

with the highest image quality, without changing the image size.

Change the settings according to your requirements.

Convert and save
[SM os: [ HETDD E]Jf— Enter a file name
( Where: .L__ Photo ‘:])7— SeleCt the save
. destination
(Kind o file Exif-JPEG 4])—— Select an image type
Image guality T e 10
Output setting
Output resolution 350 dpi [} Embed ICC profile
Resize setting
| Resize
Width Height Unit
3504 x 2336 pixe
{3504 pixel ) {2336 pixel )
¥ Lock aspect rat
(ancel ) [Esae )} Click and save

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

== To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

|§| By saving as explained on this page, a trimmed image (p.38) or
dust-erased image explained in Chapter 3 (p.73 to p.77) actually
becomes a trimmed image or dust-erased image.
You can reduce the noise characteristic of JPEG images which

occurs when you convert and save an image as a JPEG (p.89, p.90).

You can batch convert and save multiple images (p.99).
For a list of [Convert and save] window functions, see p.134.
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.25 to p.33), so the “original image data itself”
remains unaffected.

Also, the trimming range information of a trimmed image (p.38) is simply
saved to the image.

For this reason, you can undo any adjustments saved (p.41) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

" Adjustment
Rotate left L
Rotate right 3R
Work color space >
Tone Curve Assist - 5tandard
Tone Curve Assist - High

Revert to last saved settings “_3Z
Revert to shot settings ~¥Z

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with Canon inkjet printers compatible with the Canon printing software,
Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how to print
photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (Same page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.46)
Printing Photographs with a Printer other than Canon Inkjet Printers
(p.49)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint EX (hereinafter, “EPP
EX"):

Simple printing of RAW images

Printing with faithful colors

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Select the image to be printed.

Start up EPP EX.

Select the [File] menu » [Plug-in printing] » [Print with Easy-

PhotoPrint EX].

Print with Easy-PhotoPrint EX

Open in Edit window *O
Open in Edit window (enlarged)

e all

1 window M
Close window HEW
Save 35
Save As... 1+ 38S
Add thumbnail to image and save {t+3T
Convert and save... #*D
Batch process... #*B
Create new folder... {r N
Page setup... {+ 3P
Print... 3P
Print with detailed setting... {+3ED
Contact Sheet Prints... ~¥P

(] D &

Add to collection ®G
Remave from collection i ¥
Clear collection
Delete <&l
Info... #l

EPP EX starts up.

In the EPP EX window, select the [File] menu »
[Preferences].

My Recent Files b

Next Step

Preferences...

The [Preferences] window appears.

In [Print Quality], select [Quality Priority], click the
[Option] button, and then in the dialog box that
appears, checkmark [Print with the best quality when
you select [Quality Priority]].

CYaIE - Preferences ]
Print Advanced

MNumber of copies : L ; Copies

Printing Order B\,; Ij.ile T|

Amount of extension of borderless printing : = Default T'

Print Quality [ Quality Priority T|)7_ Select
CarD) Quality

Priority
( Defaults )
Help 9§ Cancel ) ( oK -)

Click and checkmark [Print with the best quality
when you select [Quality Priority]]
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Select the [Advanced] tab, checkmark [Enable ICC
profile], and then click the [OK] button.

The [Preferences] window closes.

Specify the number of sheets to be printed, and then
click [Select Paper].

EPP EX
— ﬂ- = E o s
= E kAl '”'"‘ Siae '.““"? (:)—-————"“'m Click to
h increasethe
ﬂ nﬂ “ Eé s;:m 3 number of
- sheetstobe
h printed
. | L =5 e
Click

Select the paper type, and then click the [Layout/

Print] button.

anA Biew Phata Print - Easy-FhotoPrint EX
‘Select e prinier 13 s, Tien select e sive and hpe o paper 1o prinking

Phote Print

———a L
(@ Layout/priot

e
[y

Exif Print

I nep |

Click

Specify the layout, and then click the [Print] button.

and type

s |
[ o |

GG New Fhoca Print - Easy-Phatofrint £
pre et E&:}Ehﬁ; m Exif Print
3 &
3 LIC 5 ' Select the
=y 1 0 layout

Click to print
Printing begins.

Select the
paper size

J
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Introduction

"2 Additional information Printing Photographs with Canon Inkjet

Print up to 1000 images at a time Printers Compatible with Easy-PhotoPrint

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

Contents at
You can perform the following types of photograph printing with Canon a Glance

inkjet printers compatible with Easy-PhotoPrint (hereinafter, “EPP”):

The printed image’s color is not what you expected Simple printing of RAW images

In the EPP EX window, select [Preferences] in the [File] menu and High quality printing using the color reproduction range of Adobe RGB o Bas't?

then click the [Advanced] tab in the [Preferences] window to display and a Canon inkjet printer peration

the [Advanced] tab sheet. L . .

In the [Advanced)] tab sheet, select [Enable ICC profile] in [Color ;c;eﬁeorao;rgutrhfoﬂgjl[g?’&:/:ezefgizag] téeflsr;tl:l’r;]?:)l:DEiIthPE\;?rcséﬁp?;t?bg A )
. L C : , : - - vice

Z:sqréelzt)lon for printing] and try printing using the [Perceptual setting inkjet printer, it is recommended that you print using Easy-PhotoPrint EX Opacion

(p.43). Note that since EPP is not compatible with Mac OS X 10.7,
printing is not possible with a computer running on Mac OS X 10.7.

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.87). _ ,m‘;‘;‘fggﬁf'ng
Select the image to be printed. and Printing
Processing

Start up EPP‘ ) o ) . Large Numbers
Select the [File] menu » [Plug-in printing] » [Print with Easy- of Images
PhotoPrint].

Editing
Open in Edit window #0 ‘"TEGITIFF
Open in Edit window (enlarged) mages
él;.c;s.e wmdow Sﬁ‘u\ll’ Reference
Save #S
Save As... 1r 365
Add thumbnail to image and save (3T
Convert and save... %D Index
Batch process... EB
Create new folder... {r 36N

Page setup... {r3EP

Print... #*P @ @
Print with detailed setting... %D

Contact Sheet Prints... ~3P

Plug D g Print with Easy-PhotoPrint  3E

Add to collection #C
Remove from collection 3G

EPP starts up. 46




In the EPP window, select the [Easy-PhotoPrint]
menu » [Preferences].

Easy-PhotoPrint

About Easy-PhotoPrint...

Preferences...

%)

Services

Hide Easy-PhotoPrint  3H

Hide Others C3EH
Show All
Quit Easy-PhotoPrint  3Q

>

The [Preferences] window appears.

In [Print Quality], select [Quality Priority].

Preferences

[ e
Print | Advanced

)
T

Copies

Print Number of copies : 1
Printing Order : "By Date
Amount of extension of Default

borderless printing :

Print Quality :

B
B
'4]

[ Quality Priority

) e

( Cancel

— Select
Quality
Priority

Select the [Advanced] tab sheet and check that the
EPP image compensation function is disabled.
If not disabled, the operation of the EPP image compensation
function may prevent images being printed with faithful color

reproduction.
Preferences
1' Print | Advanced
Image @ptimize images automatically

gApplv Rotate/Trimming to the same images in the same manner
When landscape images are rotated depending on the selected
® Rotate Left

) Rotate Right

Layout 1 Always trim when you select the layout with the margins

gS&t margins to the minimum when you select the layout

with the margins

g Print filename when you select the index in layout

E Preview all layouts of A4 and Letter
Image | select images from multiple folders
Selection

[ Defaults )

@ ( Cancel ) 'G—BHI

If checked,
click to

remove the
check mark

Click to
close the
window

£ Specify the number of sheets to be printed, and then
click [Next].

Eﬁ{e’h\ntwﬁnt Wien

Click

Click to
increase the
number of
sheets to be
printed

J
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Check that the image compensation function is
disabled, select the paper type and then click [Next].
If checked, click to remove the check marks

57 Fhotofrint
B

Select the
paper type

ervter ot irsegea < 14 Fager S0 - A Pidin Type - et Pager Pra 12 o)

Specify the layout, and then click [Print].

ans Lary-Fhetchnt

Click to print

Select the layout

=» Printing begins.

2 Additional information

© Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

© The printed image’s color is not what you expected

Change the [Rendering intents when using Easy-PhotoPrint] (p.93) to
[Perceptual] (p.144) and print.

@ DPP is also compatible for printing with Easy-PhotoPrint Pro (p.87).

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

48




Select the image to be printed.

Select the [File] menu » [Print].

Printing Photographs with a Printer other than Canon Inkjet Printers

You can print one image on one sheet of paper.

Open in Edit window #O
Open in Edit window (enlarged)

Open window i N
Close window HEW
Save #5
Save As... 1+ 385
Add thumbnail to image and save {3T
Convert and save... ®D
Batch process... #B
Create new folder... 1+ 38N
Page setup... it 3P
Print... %P )
Print with detailed setting... {4 #ED
Contact Sheet Prints... ~HP
Plug-in printing [ 2
Add to collection ®G
Remove from collection T+ 3G
Clear collection

Delete kR
Info... E|

The [Print] dialog box appears.

Set to photograph printing and print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.

Printing begins.

Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Deleting an Unwanted Image
Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Delete].

Open in Edit window #O
Open in Edit window (enlarged)

Close all

QOpen window 38N
Close window W
Save 35
Save As... 1+ 35S
Add thumbnail to image and save 3T
Convert and save... HD
Batch process... #B
Create new folder... 3N
Page setup... {r 3P
Print... 3P
Print with detailed setting... {4#HD
Contact Sheet Prints... ~HP
Plug-in printing >
Add to collection HG
Remove from collection {+¥#G
Clear collection

Delete SG]
Info... E |

The image is moved to the [Trash] and is deleted from DPP.
The images are deleted completely from your computer by
selecting the [Finder] menu » [Empty Trash] on the desktop.
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Creating a Folder for Saving Images

You can create a folder for sorting images.

In the folder area, select the location where the new
folder is to be created.

8006 Digital Photo P

[II[ET

Folder Collection(0)
v 24 Mac0sX
» (Al Applications
2 Temporary ltems
v |8 Users
v @ canon
» @ Desktop

» [ Documents
b [# Library

= Movies

[ & Music

v g——
b
B [ Sites

» [ shared

Select the [File] menu » [Create new folder].

Open in Edit window FO
Open in Edit window (enlarged)

Close all

Open window 3N
Close window EW
Save 5
Save As... {+ 35
Add thumbnail to image and save 3T
Convert and save... #D
Batch process... #B

( Create new folder... {+ 3N ]

Page setup... {+ 3P
Print... #P
Print with detailed setting... {+3#D

The dialog box for entering a folder name appears.

Enter a folder name and click the [OK] button.
The new folder is created in the folder selected in step 1.

Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <option> key
and release when the image is in the destination

folder.
8086 Digital Photo Profession
2 B E &
Folder Collection(0)
v =) MacOsx
P [& Applications
[ Temporary ltems
¥ & Users
v 4 canon
¥ [ Desktop
L& Travel
» | Documents
» | ® Library
|® Movies @
& Music IMG_0001.CR2

v & Pictures
v ¥ Photo
l‘,.,. XUXH_XH_HX
» & Public
» | Sites
» [F shared

The images are moved or copied to the destination folder.
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Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <option> key

and release when the folder is in the destination folder.

806 Digital Photo Profession

D (B

11113,
ir

Folder Collection(0)
v 3 Macosx
> | A Applications
| Temporary Items
¥ [¥ Users
v 1 canon
¥ [ Desktop

[ Travel
¥ |¥ Documents
b ¥ Library
& Movies @
! Music IMG_0001.CR2

Y 4

i e

b [ Sites
» [# shared

The folders are moved or copied to the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders appear by clicking the [Bookmark] menu.

Select the folder for which a bookmark is to be

registered
g .
8086 Digital Photo Profession
2B & 8 (3
Folder Collection(0)
v 3 MacOSX
» | A Applications §
[ Temporary ltems L
v & Users .
v @ canon - B
¥ [ Desktop
L& Travel Vi

STt ——

» |7 Documents =
» |® Library

&= IMG_D0D1.CR2

— g Select

Select the [Bookmark] menu » [Add].
The folder selected in step 1 is registered in the [Bookmark]
menu.
Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in
[Bookmark].

Select the [Bookmark] menu » [Organize].
The [Sort bookmarks] window appears and you can change
folder names or delete folders.
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3 Advanced Image Editing and Printing

Various preferences including advanced image adjustment, automatic
dust erasure processing, various printing functions for printing out work,
and color management are explained here, geared to the user who is
competent in the handling of third-party image editing software.

Adjusting While Comparing with the Original Image... 53
Changing How the Window is Split.............ccccoeeee 53

Adjusting by Comparing Multiple Images................. 54

Displaying an Area Beyond the Set Range as a

Warning Indicator (Highlight/Shadow Warning) ....... 95

Performing Advanced Editing............ccccoooovieiiinnnn, 56
Adjusting White Balance with Color Temperature ..... 56
Tuning White Balance with Color Wheel ................... 56
Adjusting Dynamic Range .............cccccveeeeeieeeenninnns o7
Adjusting Brightness of Shadows/Highlights ............. o7
Tone Curve Adjustment.............oooiiiiiee 58

Example of a Tone Curve Operation ..................... 29
Using a Picture Style File..........cccoooveiiiiiiiieeee. 59
About the RGB Tool Palette .............ccccceeeeiiiiinnen. 60

Using the Auto Lighting Optimizer...............c............ 61

Reducing NOISE........coooiiiiiiiiiiiii e 62

Correcting Lens Aberration ...........ccoooovvviiiiieeeennnnnnn. 63
Compatible Cameras..........ccccoeeeeiiiii 63
Compatible Lenses.......ccccoeeeeeiiiiiie 63
Making Corrections.............ceevveeeeeiiiiiiiieeeeee e 65

Effects of Distortion Aberration Correction for Fisheye

LENSES...ciiiieiieeeeeeeeeeee 66
About Shooting Distance Information Slider.............. 68
Correcting Multiple Images ata Time............cccccc...... 68

Using the Digital Lens Optimizer ............ccccccooeoee. 69
Compatible Cameras.............cccceeoeiiiiiiiieeeee, 69
Compatible Lenses...........ccccoeeeieiiiiiiiiii 69
Using the Digital Lens Optimizer..........ccccccoeeeieiiennnnn. 70

Performing Automatic Dust Erasure Processing ..... 73
Compatible Cameras............ccccccvviiieeeieeeeeeee e, 73
Automatic Dust Erasure Processing in the Main Window... 74

Manually Erasing Dust (Repair Function)................ 75
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCLION). .. 77

Transferring a RAW Image to Photoshop................ 77

Setting Work Color Space ...........ccoovvvvvvveiiiinciennnnn. 77

Compositing Images.........cccceevvieiiiiiieeeeecee e 78
Compositing Methods..............coooiiiiiiiiiieee e, 81

Creating HDR (High Dynamic Range) Images........ 81

Starting Up Map ULility ........cccooeveeiiiiiie 84

Printing with Shooting Information........................... 85

Printing a Thumbnail List (Contact Sheet Printing).. 86

Printing RAW Images on a High-End Canon Printer.. 87
Printing with a High-End Canon Inkjet Printer ............ 87
Printing with a Large-Format Canon Printer............... 88

Specifying Preferences.........ccccocceivieiiiiiiiiieeeeiinn. 89
General SettingS.......ccovvveiiiiiiiiii e, 89
View SettingS.......oooeeiiiiiiiieeee e 91
Tool Palette ... 92
Color Management.............cooovcciviiiiiieeee e, 93

Introduction

—_—

Contents at
a Glance

—_—

Basic
Operation

Advanced
Operation

Advapced
Imag iting
and Pfinting

Processing
Large Numbers

of Images
N ——

Editing
JPEGI/TIFF
Images

Reference




Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the
same window and adjust while checking the adjustment results.

In the edit window, select the [View] menu » [Before/
after comparison].

| iy e v o ey ‘

The image divides into a left and right window.
The window on the right shows the image after editing.

Change the image display.
Select the [View] menu » [Change up/down/left/right] » [Up/
down].

i wiy v v =

The layout of the two images changes to top and bottom.
The bottom window shows the image after editing.

|§| Images can also be displayed in the edit image window by the same
operation.

Changing How the Window is Split

You can change the display of the image to a single image split in two.

In the edit window, select the [View] menu P [Display
mode] » [Split smgle |mage]

| E——— [ I -

=» One image is divided and displayed on the left and right or top
and bottom.

@ To switch between top and bottom, and left and right, perform the
same operation as step 2 on the left page.
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Adjusting by Comparing Multiple Images

Introduction

You can synchronize the display position of multiple edit windows and Move the display position.
adjust images while comparing them with each other. If you move the enlargement display position in one of the edit
T ] . : windows, the enlargement display position will also change in the Contents at
In the edit window, display the multiple images to be other edit windows. a Glance
compared. To cancel synchronization, select the [Window] menu » —
Align the images. [Synchronize] again. Basic
Align the images for easy comparison. Operation

Select the [Window] menu » [Synchronize].

Advanced
Operation

Enlarge the image.
Enlarge and display any of the edit windows.

[ :nn:.m:n...m.....,.... [ |..,.-_.-_: = Tosh _Wndes e — : = .. .w-:snm 5] Ad ced
ez Imag iting
o A and Pfinting

< | Processing
ol L E _TAr Large Numbers
e - of Images

—— ."'.“f""“l — e ) Editing
JPEGI/TIFF
Images

-

e Reference

i
o T

The other edit windows will also be displayed in the same
position/enlargement ratio. ——

@ Synchronization only applies to the enlargement display position @
and the enlargement ratio. Adjustments to the images are not

synchronized.
54



Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning)

You can set up a warning indicator in both the highlighted part and the
shaded part, which is effective for checking the light and dark areas and
preventing excessive adjustment of an image. Where the area on the
image has exceeded that set range, you can display the highlighted part
in red and the shaded part in blue.

Select the [Digital Photo Professional] menu »
[Preferences].

Select the [View settings] tab sheet.

Enter the warning value for [Highlight] and [Shadow].

-
Preferences

GCeneral settings | Wiew { | Tool palette Color management

Grid pitch
64 Pixels(B-256)

Locking selected image

a Images opened in Edit window remain selected in main window

Magnification in Edit window

#) Fit to window ) 50% ) 100% ) 200%

Magnification when the Edit/Edit image window is double-clicked

® 50% O 100% O 200%

RAW and JPEG
g Display only CR2 images for CR2 and JPEC files of the same name

Sort order in main window
™ Retain sart order

Highlight/shadow warning

Highlight 255 | a9z-255) [N
Shadow 0 | (0-64) Ee—— |
Quick check tool display
@ 50w () 100% (moiré reduction off)
{ Cancel 3 ( 0K ’

Click the [OK] button to close the window.

Display the edit window.

Select the [View] menu » [Highlight]. Similarly, select
[Shadow].
On the opened image, if there is an area that exceeds the value
entered in step 3, the highlighted part of that area is displayed in
red and the shaded part is displayed in blue.

|§| You can also display the warning with the same operation in the edit
image window.
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Performing Advanced Editing

This section explains how to use the advanced adjustment function on
the tool palette in the edit window.

Adjustments made using the high-level functions of the [RAW] and
[RGB] tool palettes, as well as the functions of the [NR/ALO] and [LENS]
tool palette are explained in this section.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

[ RAW | RGB  NR/ALO = LENS

‘Erightness adjustment | = i‘

;|:.::::|..:q;|:.:|::|.. QDD
‘While balance adjustment = :‘

l?‘ 1 S Register... |
( Color temperature .:])’ Tune..

) .
7 (sso0_k)——— Displays the value of the

setting
Drag the slider left or right

|§| The adjustment range is 2500 to 10000K (in 100K units).

Tuning White Balance with Color Wheel

White balance can be tuned by moving a cursor in the color direction
shown in the color wheel.

In the [RAW] tool palette, click the [Tune] button.

Tune by dragging a point.
You can also fine-tune your adjustment by directly entering the
adjustment values.

o ‘White balance fine adjustment
Color tone; —— Enter the values
Color saturagion: to set

Cancel ! f oK *

Drag

@ To register adjustment results as personal white balance (p.98),
select a setting other than [Shot settings] from the [White balance
adjustment] list box, and then tune with the color wheel. You
cannot register the adjustment results as personal white balance
when you have selected [Shot settings] from the list box and have
done any tuning.

You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

|§| The adjustment range of color tone is 0 to 359 (1 unit in numerical
value input), and the adjustment range of color saturation is 0 to 255
(1 unit in numerical value input).
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Introduction

Adjusting Dynamic Range Adjusting Brightness of Shadows/Highlights ———
Dynamic range (width of gradation expression) from dark points to bright You can adjust the brightness of shadows and highlights in an image. Contents at
points in an image can be adjusted. By adjusting shadows and highlights in an image with a restricted a Glance

brightness, you can reduce the effects of clipping in shadows and —
g highlights.
|P|clure Style =) i| Basic
=g ""'; Move downwards Operation
P Standard = Brc-w‘se... - Output highlight points |pictum Style i;?....ﬂ
Standard | :] { Browse.. )
Move to the left or right . , . ég‘é?:ggg
Input highlight points '
r‘—lllﬂ e = .0
: Advapced
Contrast: 1)) IE?I e § : 1 i A |mag‘5ﬂting
Highlight: {i1){ =—— 210 ATNGEIR A0 W0 0 20 40 and Pfinting
Shadow: (W ,@, sy Contrast; . s
! Linear Move upwards Highlight: 0) Drag the sliders left or Processin
Color tone: o L i R OUtpUt ShadOW pOIntS Shadow: 100 e T Trlght Large Numbg's
Color saturation: 10) '—I—I—I-I'@I—I—I-T ) Linear of Images
Unsharp mask 4] Caolar tone: 0 WT —
Strength: () N —— Color saturation: (0} T — Editing
Finaness: i0) m Unsharp mask | :! JPEG/TIFF
Threshold: () ME— Strangth: {0 Em— Images

Move to the left or right :::::d ig; @_.

Input shadow points s Reference
The horizontal axis shows the input level and the vertical axis —
shows the output level.

Index
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Introduction
Make adjustments.

Batch adjusts RGB

Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by Adjusts each channel Contents at
changing the tone curve (p.143). - ; a Glance
RAW | RGB MNR/ALO LENS *
Tone curve assist
In the tool palette, select the [RGB] tab sheet. | —LQ‘
Tone cprve adjustment - ‘ Basic
. . RGE | R |G| s J y" Opsration
Select the tone curve mode and interpolation —
3
method.
Advanced
| RAW | RGB | NR/ALO LENS | Operation
|T0ne CUrve assist O+ BPe ‘
Tone curve adjustment b ‘
— gl . . Advapced
- OOD =] Click to add a [C] (point) Imag‘gji_ting
255 ' Adjust by dragging [[] and Pfinting
Processing
Large Numbers
of Images
v Curve = o)
Straight < | __2;_5_4
<control> + click inside Editing
Luminance R G B menu Cohirist: —— Images
Hue: ,—:\:}—- 3 0 i
Saturation: e (o] 100 Reference
T _ ) Sharpness: o A—— _—EI:
| o] | 255] —— -
Beibitnese: — ol The horizontal axis shows the input level and the vertical axis
Contrast: ol shows the output level. Index
PRI The maximum number of [[]] is 8. -
e e e To delete a [[], double-click on the [[]].
Saturation: ":"\, 3 100 ;

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.92).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.92).

©
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Example of a Tone Curve Operation
Makes medium tones brighter Makes medium tones darker

Using a Picture Style File

A Picture Style file is an extended function file of a Picture Style.

Contents at
With DPP, you can apply to RAW images Picture Style files that you a Glance
/ have downloaded from Canon’s web site effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
/ Picture Style file, save it to your computer beforehand. Basic
Operation
/' / Display the image to which the Picture Style file is to
/ be applied in the edit window (p.11). Advanced
. Operation
Select the [RAW] tab sheet in the tool palette, and
click the [Browse] button.
Advapced
‘Picture Style ) ‘ |mag‘5ﬁting
and Pfintin
(Seandard o) -
Makes tones harder Makes tones softer A | “ A f Processing
Large Numbers
/ of Images
: _ A L Editing
] -10.0 -3.0 -6.0 -4.0 =-2.0 0 2.0 4.0 JPEG/TIFF
1
/ The [Open] dialog box appears. R
Select a Picture Style file saved on your computer,
and click the [Open] button. elsienes
i The Picture Style file you selected is applied to an image.
To apply a different Picture Style file, follow the procedure from
step 2 again. Index

ﬁl The Picture Style files that you can apply to the camera are files with
the “.PF2” extension only. Furthermore, you cannot apply Picture
Style files with the extension “.PSE” to an image; however if such a
file is registered in the camera and the image is shot, the image will

display correctly. 59



About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your
editing requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the functions in the [RGB]
tool palette is wider than the [RAW] tool palette, the image color may be
saturated, or the image quality may deteriorate if you adjust too much.
Therefore we recommend for functions other than tone curve
adjustment (p.58) and automatic adjustment (p.33), that you adjust
images using the same functions available in the [RAW] tool palette.
See Chapter 5 for explanations on functions of the [RGB] tool palette
other than tone curve adjustment.

E\@/E Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/ALO] and [LENS] tool palette
(p-129) when applying the Auto Lighting Optimizer (p.61), reducing
noise (p.62) or correcting aberration (p.63) after you have made any
required adjustments with the [RAW] and [RGB] tool palettes.
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Using the Auto Lighting Optimizer
If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more pleasant image.

You can also change the settings of the image shot with the camera’s
Auto Lighting Optimizer function.

This function is compatible only with RAW images shot with EOS-1D X,
EOS-1D Mark 1V, EOS 5D Mark Ill, EOS 5D Mark I, EOS 7D, EOS 60D,
EOS 50D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL
T2i/550D, EOS REBEL T1i/500D and EOS REBEL T3/1100D.

* ALO stands for Auto Lighting Optimizer.

Select the [NR/ALO] tab sheet from the tool palette in
the edit window or edit image window.

[ raw  RGB || NRfALO ) LENS |
|Autn Lighting Optimizer |
E 1 \l/ 1
Low  Standard  Strong
|Noise reduction Apply |
RAW " MR Preview... ol
Luminance noise reduction
{21 D trrrrrrrrrrrrrrrnrren 20
Chrominance noise reduction
{SJ D trrrrYrrrrrrrrrnennnn 20
TIFF/JPEG
Luminance noise reduction
[()] 0 20
Chrominance noise reduction
[)] 0 " 20
Lens aberration correction Tune... |
Peripheral illumination 35
Chromatic aberration OFF
Color blur OFF
Distortion OFF

Checkmark the checkbox.

I RAW  RGB | NR/ALD | LENS |

‘Autu Lighting Optimizer

® — <

Low Standard  Strong

Checkmark

For images shot with the camera’s Auto Lighting Optimizer
function, the checkbox is already checked.

Change the settings according to your preferences.

I RAW  RGB | NR/ALD | LENS |

‘Autu Lighting Optimizer

— S

Low Standard  Strong

Select from three levels:
Low/Standard/Strong

Auto correction is applied to the image to match the settings.
For images shot with the camera’s Auto Lighting Optimizer
function, the settings at the time of shooting are applied as the

default values.

To cancel the Auto Lighting Optimizer, remove the check mark

from the checkbox.

When [Highlight tone priority] is set to [Enable] in EOS-1D X, EOS
5D Mark 1ll, EOS 7D, EOS 60D, EOS REBEL T4i/650D, EOS
REBEL T3i/600D, EOS REBEL T2i/550D and EOS REBEL T3/
1100D, the Auto Lighting Optimizer function cannot be set.

You cannot use the Auto Lighting Optimizer with multiple-
exposure RAW images created on the camera.
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Reducing Noise

You can reduce noise that arises in RAW images shot at night or with a
high ISO speed.
NR is an abbreviation for “noise reduction”.

Select the [NR/ALO] tab sheet from the tool palette in
the edit window or edit image window.

Click the [NR Preview] button.
|Noise reduction

RAW [[ NP Preview... |

The [NR Preview] window appears.

Adjust an image.

8NN NR Preview

Navigator
window

— Enlargement

display
position
Luminance noise reducty
I\ 2 Drag the
o 2 sliders

( Cancel

D Y —

NR check| window
You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.
The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.
You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.

Noise reduction is applied to the image and the image is
redisplayed.

? The noise reduction function does not work

Noise reduction cannot be applied when [Viewing and saving RAW
images] (p.89) is set to [High speed] in the [Preferences] window.
Select [High quality] to reduce noise.

VL
-~ To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/ALO]
tool palette (p.129) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

i

You can set the default noise reduction beforehand, using
[Default noise reduction settings] in the [Tool palette] tab sheet in
the [Preferences] (p.92).

* When [Apply camera settings] is selected, you can pre-set a
noise reduction level that suits the camera settings beforehand
as the default.

* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand. This is
particularly useful for applying noise reduction to all the images
in a folder at once, such as batch noise reduction for images
with high 1ISO speeds.

However, for images with recipes attached, the noise level

recorded in the recipe will be applied.

If [Luminance noise] has been set, resolution may be reduced

along with reduction of noise.

If [Chrominance noise] has been set, color bleeding may occur

along with reduction of noise.

For a list of [NR Preview] window functions, see p.131.
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Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that you can only correct RAW images which have been
taken with the compatible cameras and lenses listed below. JPEG or
TIFF images cannot be corrected.

Compatible Cameras

EOS-1D X EOS-1D Mark IV EOS-1Ds Mark Ill

EOS-1D Mark Il EOS-1D Mark IN  EOS-1Ds Mark II

EOS-1D Mark Il EOS-1Ds EOS-1D

EOS 5D Mark Ili EOS 5D Mark Il EOS 5D*1

EOS 7D EOS 60D EOS 50D

EOS 40D EOS 30D*2 EOS REBEL
T4i/650D

EOS REBEL EOS REBEL EOS REBEL

T3i/600D T2i/550D T1i/500D

EOS DIGITAL REBEL EOS DIGITAL REBEL EOS REBEL

XSi/450D XTi/400D DIGITAL ~ T3/1100D

EOS DIGITAL REBEL L o

XS/1000D

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

Compatible Lenses

Fisheye, ultra wide, and wide angle lenses

EF 14mm f/2.8L USM

EF 8-15mm f/4L USM Fisheye*3

EF 20mm /2.8 USM

EF 24mm f/1.4L Il USM*3
EF 24mm /2.8 IS USM*3
EF 28mm /2.8

EF 35mm f/1.4L USM

EF 14mm f/2.8L [l USM*3
EF 15mm f/2.8 Fisheye*3
EF 24mm f/1.4L USM

EF 24mm /2.8

EF 28mm /1.8 USM

EF 28mm /2.8 IS USM*3
EF 35mm /2

Standard and medium telephoto lenses

EF 50mm f/1.2L USM*4
EF 50mm /1.8

EF 85mm f/1.2L USM
EF 85mm /1.8 USM

EF 50mm f/1.4 USM

EF 50mm /1.8 1l

EF 85mm f/1.2L Il USM*>
EF 100mm f/2 USM

Telephoto lenses

EF 135mm f/2L USM

EF 200mm f/2L IS USM*3
EF 200mm /2.8L Il USM
EF 300mm /2.8L IS USM
EF 400mm f/2.8L IS USM
EF 400mm /5.6L USM
EF 500mm /4L IS USM
EF 600mm /4L IS USM

EF 800mm f/5.6L IS USM*3

EF 135mm /2.8
(with Softfocus mechanism)

EF 200mm /2.8L USM

EF 300mm f/2.8L IS Il USM*3
EF 300mm f/4L IS USM

EF 400mm f/2.8L IS Il USM*3
EF 400mm f/4 DO IS USM
EF 500mm f/4L IS 1l USM*3
EF 600mm f/4L IS Il USM*3
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Zoom lenses

EF 16-35mm f/2.8L Il USM*3
EF 17-40mm f/4L USM

EF 24-70mm f/2.8L USM

EF 24-85mm f/3.5-4.5 USM
EF 28-70mm f/2.8L USM

EF 28-90mm f/4-5.6 Il USM
EF 28-90mm f/4-5.6 Il

EF 28-105mm f/3.5-4.5 USM
EF 28-105mm f/4-5.6 USM

EF 16-35mm f/2.8L USM

EF 17-35mm f/2.8L USM

EF 20-35mm /3.5-4.5 USM
EF 24-70mm f/2.8L Il USM*3
EF 24-105mm f/4L IS USM
EF 28-90mm f/4-5.6 USM

EF 28-90mm f/4-5.6

EF 28-90mm f/4-5.6 Il

EF 28-105mm /3.5-4.5 || USM
EF 28-105mm /4-5.6 EF 28-135mm /3.5-5.6 IS USM
EF 28-200mm /3.5-5.6 EF 28-200mm /3.5-5.6 USM

EF 28-300mm /3.5-5.6L IS USM EF 55-200mm /4.5-5.6 1| USM
EF 55-200mm f/4-5.6 USM EF 70-200mm /2.8L USM

EF 70-200mm f/2.8L IS USM EF 70-200mm f/2.8L IS 1l USM*3
EF 70-200mm f/4L USM EF 70-200mm f/4L IS USM*4

EF 70-300mm f/4-5.6L IS USM*3 EF 70-300mm f/4-5.6 IS USM
EF 70-300mm f/4.5-5.6 DO IS USM EF 75-300mm f/4-5.6 11*3

EF 75-300mm f/4-5.6 I11*3 EF 75-300mm f/4-5.6 USM

EF 75-300mm /4-5.6 [l USM EF 75-300mm /4-5.6 Il USM
EF 90-300mm f/4.5-5.6 EF 90-300mm f/4.5-5.6 USM

EF 100-300mm f/4.5-5.6 USM EF 100-400mm /4.5-5.6L IS USM

Macro lenses
EF 50mm f/2.5 Compact Macro*3 EF 100mm f/2.8 Macro USM
EF 100mm f/2.8L Macro IS USM*3 EF 180mm f/3.5L Macro USM

MP-E 65mm /2.8 1-5x Macro
Photo*3

EF-S lenses
EF-S 60mm /2.8 Macro USM EF-S 10-22mm f/3.5-4.5 USM
EF-S 15-85mm /3.5-5.6 IS USM*3 EF-S 17-55mm /2.8 IS USM
EF-S 17-85mm f/4-5.6 IS USM  EF-S 18-55mm f/3.5-5.6
EF-S 18-55mm /3.5-5.6 1| EF-S 18-55mm f/3.5-5.6 I11*3
EF-S 18-55mm f/3.5-5.6 USM EF-S 18-55mm f/3.5-5.6 Il USM
EF-S 18-55mm f/3.5-5.6 IS*3 EF-S 18-55mm f/3.5-5.6 IS 11*3
EF-S 18-135mm /3.5-5.6 1S*3 EF-S 18-135mm f/3.5-5.6 IS STM*3
EF-S 18-200mm /3.5-5.6 1S*3 EF-S 55-250mm f/4-5.6 1S*3
EF-S 55-250mm /4-5.6 IS II*3 —_—

Aberration correction will not apply to images shot with a combination
of lenses *3 *4 *5 and EOS 5D or EOS 30D with the firmware versions
below.

* You cannot attach an EF-S lens to EOS 5D.

*3 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.5 or earlier

*4 EQOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

*5 EOS 5D with firmware version 1.0.5 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

You can also correct RAW images taken with the compatible lens
even when the extender is attached.

You can also correct RAW images shot with EF 50mm /2.5
Compact Macro fitted with Life Size Converter EF.

The aberration correction function is not available for images shot
with combinations of camera/lens other than those given under
“Compatible Cameras” and “Compatible Lenses”. They are
therefore not displayed and cannot be used.

The chromatic aberration correction function is not available for
multiple-exposure RAW images created on the camera.
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Making Corrections

You can make corrections to any of the four aberrations as below, either
one at a time or simultaneously.
Peripheral illumination
Chromatic aberration (color fringing which occurs in the periphery of
an image)
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)
Distortions

In the tool palette, select the [LENS] tab sheet.

Click the [Tune] button.

I

RAW RGB  NR/ALO | LENS |

|Digil.a| Lens Optimizer e —

Setting OFF

Lens data No

[ Update... |
Lens aberraticn correction [ —— ]|
Peripheral illumination OFF
Chromatic aberration QOFF
Color blur OFF
Distortion QFF

The [Lens aberration correction] window appears.

Checkmark the items to be corrected.

L e —_—

Lens aberration cerrection - [IMG_0001.CR2)

The image is corrected and redisplayed.

Check the results of corrections to peripheral illumination or
distortions in the full view.

Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check. In the
top right of the window, the area is displayed at 200% in the
enlargement display section (p.136).

You can lessen the degree of correction by moving the slider to
the left for the item you want to correct.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

To correct distortion aberration of images shot with a fisheye lens
(EF 8-15mm f/4L USM Fisheye or EF 15mm /2.8 Fisheye), four
effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

The level of an effect can be adjusted with the adjustment slider
located below [Distortion].

For detailed information on each effect, see “Effects of Distortion
Aberration Correction for Fisheye Lenses” (p.66).
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For images shot with EF 8-15mm /4L USM Fisheye, a fine-tune
slider is also displayed when you select [Emphasize Linearity]
from the [Effect] list box.

Adjust the amount of correction for distortion aberration with the
adjustment slider, and then adjust with the fine-tune slider if more
adjustment is required.

When the list box for selecting an extender is displayed, select
the extender attached at the time of shooting from the list box.

Click the [OK] button.

The [Lens aberration correction] window closes and the result of
the corrections is applied to the image in the edit window and the
image is redisplayed.

The result of the settings of the [Lens aberration correction]
window is also displayed in the tool palette.

In the main window, the [Q}DJ] mark is displayed on the image to
indicate the lens aberration corrections (p.126).

Effects of Distortion Aberration Correction for
Fisheye Lenses

Shot settings

By selecting this option, only distortion aberration correction for
correcting optical distortion is performed.

Emphasize Linearity

This converts the image to a “central projection” style image. This
projection method is used with general lenses.

Differing from fisheye lenses, central projection displays straight lines
as straight lines.

By selecting this option, a wide-view panoramic image can be
obtained. However, the periphery is stretched, resulting in decreased
resolution.
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Emphasize Distance

This converts the image to an “equidistant projection" style image.
This projection method preserves distance relationships.

Equidistant projection displays the same distances from the center to
the periphery as the same distances.

In particular, when shooting a celestial body such as the celestial
sphere, any height above the horizon (declination) is captured at an
equal interval. This method is therefore used in such photography as
celestial photography (star maps, solar path diagrams, etc.).

Emphasize Periphery

This converts the image to a “stereographic projection” style image.
This projection method emphasizes the periphery.

Stereographic projection allows position relationships on a spherical
surface, such as N, S, E, W on a map, to be displayed correcily. It is
therefore used for world maps and monitoring cameras.

By selecting this option, the periphery is stretched and may result in
decreased resolution.

Emphasize Center

This converts the image to an “orthogonal projection” style image.
With this projection method, the center is more emphasized.

Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography.

By selecting this option, the center is stretched and may result in
decreased resolution.

® While selecting any of the options [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center] will yield results similar to each of the projection methods,
the conversion does not exactly apply each projection method in
their precise sense.
Accordingly, care should be taken since they are not suited to
scientific or other such purposes.
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About Shooting Distance Information Slider

When correcting RAW images shot with the cameras in the table below,
if shooting distance information has been saved to the image, the slider
is set automatically according to this shooting distance information.
However, if no shooting distance information is saved to the image, the
slider is set automatically to the right end at infinity position and a [<!>]
appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

EOS-1D X EOS-1D Mark IV EOS-1Ds Mark Il

EOS-1D Mark Il EOS 5D Mark llI EOS 5D Mark Il

EOS 7D EOS 60D EOS 50D

EOS 40D EOS REBEL EOS REBEL
T4i/650D T3i/600D

EOS REBEL EOS REBEL EOS DIGITAL REBEL

T2i/550D T1i/500D XSi/450D

EOS REBEL EOS DIGITAL REBEL L

T3/1100D XS/1000D

When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.

EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark Il
EOS-1Ds EOS-1D EOS 5D
EOS 30D EOS DIGITAL REBEL

XTi/400D DIGITAL

For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF
50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

[Shooting distance information] slider is applied to all the correction
items with check marks.

Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool
palette by clicking the [Tool palette] button (p.124) in the toolbar. If you
perform correction procedures (p.65) when tool palette is displayed, you
can apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.41).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.62). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p.31).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.29) and/or the color saturation (p.107) to
make the color deeper.

The result of [Color blur] correction cannot be detected

[Color blur] correction is effective for correcting blue or red color blur
which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

® The periphery of the image may be truncated when [Distortion]
correction is made.

|§| For a list of the [Lens aberration correction] window functions, see
p.136.
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Using the Digital Lens Optimizer

This function enables the resolution of images to be increased by
removing any remaining aberration related to image-forming capability
or any deterioration of resolution resulting from diffraction phenomena
that are unavoidable as long as light must pass through the lens. These
optical phenomena cannot be corrected under [Lens aberration
correction] (p.63). Correction is achieved using the designed value of
each lens. The images that can be corrected are RAW images shot
using any of the following “compatible cameras” and “compatible
lenses”. JPEG, TIFF, S-RAW, and M-RAW images cannot be corrected.
To use this function, [Lens data] for the lens used to shoot images first
needs to be downloaded to your computer.

Before using the Digital Lens Optimizer, it is recommended that you set
[Sharpness] or [Strength] for [Unsharp mask] for images to 0.

Compatible Cameras

EOS-1D X EOS-1D Mark IV EOS-1Ds Mark Il

EOS-1D Mark Il EOS-1D Mark II N EOS-1Ds Mark Il

EOS-1D Mark I EOS-1Ds EOS-1D

EOS 5D Mark Il EOS 5D Mark Il EOS 5D*1

EOS 7D EOS 60D EOS 50D

EOS 40D EOS 30D*? EOS REBEL
T4i/650D

EOS REBEL EOS REBEL EOS REBEL

T3i/600D T2i/550D T1i/500D

EOS DIGITAL REBEL EOS DIGITAL REBEL EOS REBEL
XSi/450D XTi/400D DIGITAL T3/1100D

EOS DIGITAL REBEL
XS/1000D

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

Compatible Lenses

Wide angle lenses
EF 14mm f/2.8L Il USM EF 24mm f/1.4L Il USM
EF 35mm f/1.4L USM —

Standard and medium telephoto lenses
EF 50mm f/1.4 USM EF 50mm f/1.2L USM
EF 85mm f/1.2L Il USM —

Telephoto lenses
EF 300mm f/2.8L IS Il USM EF 400mm f/2.8L IS Il USM
EF 500mm f/4L IS Il USM EF 600mm f/4L IS Il USM

Zoom lenses
EF 16-35mm /2.8L USM EF 16-35mm /2.8L Il USM
EF 17-40mm f/4L USM EF 24-70mm f/2.8L USM
EF 24-70mm f/2.8L 1l USM EF 24-105mm f/4L IS USM
EF 28-300mm f/3.5-5.6L IS USM EF 70-200mm f/2.8L IS USM
EF 70-200mm f/2.8L ISI1USM  EF 70-200mm f/4L USM
EF 70-200mm f/4L IS USM EF 70-300mm f/4-5.6L IS USM

EF 100-400mm f/4.5-5.6L IS USM —

EF-S lenses
EF-S 10-22mm f/3.5-4.5 USM EF-S 15-85mm /3.5-5.6 IS USM
EF-S 17-55mm /2.8 IS USM EF-S 17-85mm f/4-5.6 IS USM
EF-S 18-135mm f/3.5-5.6 IS EF-S 18-135mm /3.5-5.6 IS STM
EF-S 18-200mm f/3.5-5.6 IS —

@ The Digital Lens Optimizer is not available for images shot with
an extender mounted on a compatible lens.
You cannot use the Digital Lens Optimizer with multiple-exposure
RAW images created on the camera.
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Introduction
. . . . Click the [Update] button.
Using the Digital Lens Optimizer [Update]
" RAW = RGB = NR/ALO | LENS |
Digital Lens Optimizer [ — ] Contents at
In the tool palette, select the [LENS] tab sheet, and | | a Glance
- Settin QFF
check the status of [Lens data] for [Digital Lens ’
Optimizer]. Lens data No BaSiC
([_Update.. ] Operation
{ RAW = RGB  NRJALO | LENS |
|Digita| Lens Optimizer [T] | |Lens aberration correction |
Advanced
Setting OFF The [Add or Remove lens data] window appears. Operation
( Lens data Mo )
AdvEpced
Imag iting
|Lens aberraticn correction [ — ] | and ntlng
[Not Available] is displayed for an image shot with a non- Processing
compatible camera or lens, or for a non-compatible image such La;%ﬁrﬂggggrs
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot
be used for these images. Editi
If [No] is displayed, proceed to step 2. To use the function, you JPEé/I¥|gFF
need to download [Lens data] for the lens used when shooting Images

the image. It is recommended that you check the lens used when
shooting the image beforehand. The lens used can be checked

using the [Info] button in the toolbar on the main window (p.23). Reference
If [Yes] is displayed, proceed to step

Index

00

© To use this function, an environment with Internet access

(subscription to a provider, browser software installed, and an in-
place line connection) is required.

An administrator-level privilege is required for this operation.

|§| Before you click the [Update] button in step 2, Lens data [No] may
be displayed instead of [Not Available] for non-compatible images.
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)
Introduction
Checkmark the checkbox for the lens used to shoot 4 Click the [Tune] button. |
the image, and click the [Start] button. L Raw  RcB  NR/ALO | LENs || )
Add or Remove lens data |Digital Lens Optimizer ( [ Tune... ]] Contents at
a Glance
- Setting 50 L
| EF500mm F4L IS Il USM
| EFGO0mm F4L IS Il USM
) EF16-35mm F2.8L Il USM L3t R hes Basic
[} EF16-35mm F2.8L USM -
[ EF17-40mm FAL USM Operation
] EF24-70mm F2.8L Il USM L
C) EF24-70mm F2.8L USM =»The [Digital Lens Optimizer] window appears.
| EF24-105mm F4L IS USM
] EF28-300mm F3.5-5.6L IS USM
| EF70-200mm F2.8L 15 1l USM Advan?ed
|_| EF70-200mm F2.8L IS USM operatlon

EF70-200mm F4L USM (Add)
U-3U00mm F4-5.6 OSW

Ad\acj:ed
Imag iting
and Pfinting
Processing
=»The lens data is downloaded to your computer. Large Numbers
-»When the downloading of the lens data ends, the indication for | of Images
[Lens data] changes to [Yes].
@ You can download the data for several lenses at the same time. JPEEd(I;/I'IFlgFF
@ If you remove the check mark from the checkbox for already- Images
downloaded lens names and click the [Start] button, the lens data \
will be deleted from your computer.
Reference
® Depending on the type, current state, etc. of software running on L
your computer, the download of the lens data may fail. If it occurs,
wait for a while then try downloading the data again. -

00
©
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Checkmark the [Setting] checkbox and adjust the

image.
o M) | Digital Lens Optimizer - [IMG_9416_01. CR2]
h {__ﬂ& —
~ e G !f"‘ N~
N - ;
h - Y
-',‘ -
'E_L . kil
\ N
* Shooting distance information
. ~ £
i oD
(Esming (100) ]
5 v

] 100

b
\ Cancel J Save P

Use the slider to adjust the Digital Lens Optimizer effect.

When [MAX] is displayed for the Digital Lens Optimizer level, the
effect will remain the same even if you move the slider further to
the right.

You can change the display position of the check window by
dragging the enlargement display position in the navigator
window.

Even if you set shooting distance for a lens in this window, the
value indicated for shooting distance in the [Lens aberration
correction] window will not change.

If no shooting distance information is saved to the image, the
shooting distance slider is set automatically to the right end at
infinity position and a [<!>] appears above the shooting distance
slider.

Images cannot be corrected for [Chromatic aberration] in [Lens
aberration correction] if the Digital Lens Optimizer has been
applied.

Click the [Save] button.

The [Setting] checkbox will be checkmarked if the image has the
Digital Lens Optimizer already applied. Remove the checkmark
and click the [Save] button to cancel the Digital Lens Optimizer.
In the [Digital Lens Optimizer] window, images are displayed with
[Sharpness] and [Unsharp mask] effects applied.

When applying the Digital Lens Optimizer, the effect of
[Sharpness] or [Unsharp mask] may become excessive. It is
recommended that you set [Sharpness] or [Strength] for [Unsharp
mask] for images to 0 before using the Digital Lens Optimizer.
Adjust [Sharpness] or [Unsharp mask] again after applying the
Digital Lens Optimizer to images.

Cancel E‘.: Save }

The [Digital Lens Optimizer] window closes and correction
results are applied to the image in the edit window.

Corrections made in the [Digital Lens Optimizer] window are also
displayed in the tool palette.

In the main window, the [%] mark is displayed on the image to
indicate that the Digital Lens Optimizer is applied (p.126).

After clicking the [Save] button, the application of the corrections
to the image may take some time.

The size of the image file will be larger after applying the Digital
Lens Optimizer.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera

that can attach this data, can be used to automatically erase dust spots.

Compatible Cameras

EOS-1D X EOS-1D Mark IV

EOS-1D Mark Il EOS 5D Mark Il

EOS 7D EOS 60D

EOS 40D EOS REBEL
T4i/650D

EOS REBEL EOS REBEL

T2i/550D T1i/500D

EOS DIGITAL REBEL EOS REBEL
XTi/400D DIGITAL T3/1100D

EOS-1Ds Mark 11l
EOS 5D Mark Il
EOS 50D

EOS REBEL
T3i/600D

EOS DIGITAL REBEL
XSi/450D

EOS DIGITAL REBEL
XS/1000D

In the main window, select an image appended with

Dust Delete Data.

Click the [Stamp] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

The copy stamp window appears.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

L idla] 1 113 AC_00%0.CRZ (1436 = 2504]

~»Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.

-, The [&] mark (p.126) is displayed on an image from which dust

spots have been erased.
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? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.75) or the copy stamp function (p.77).

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, see p.140.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

ﬁ@@@@

Rotare right Lk.ll:l :ﬂanp Tru‘n g Bat h

The copy stamp window appears.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

@ 3 WAG_OS40.CR2 VAT x 25041

® __ Double-
— = click

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spot to be
erased.
If the dust spot is dark in color, click the [ @ |] button, and if
the dust spot is light in color, click the [  »( ] button.
When you move the cursor over the image, the dust erasure
range appears as [O].

Place the dust spot to be erased within the [O] and
click.

r = 1718 C_D0V0 A2 (1456 = 21041

e e Click

The dust spot within the [O] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.

When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.

The [8,] mark (p.126) is displayed on an image from which dust
spots have been erased.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.77).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <3B> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <shift> key, and then displaying the copy
stamp window.

® For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

@ For a list of the copy stamp window functions, see p.140.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1 to 3 in “Manually Erasing Dust (Repair
Function)” (p.75).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [@,] mark (p.126) is displayed on a corrected image.

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu » [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, see p.100.

@ Compatible versions of Photoshop are CS or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.143) is added. The ICC profile
contains information about [Preferences] (p.93) or work color
space set for each image as described below and the appropriate
color information is relayed to Photoshop.
When you quit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred

image as a separate image in Photoshop is highly recommended.

For CS4 or later versions of Photoshop, this function is not
available if a 32-bit version is not installed.

Setting Work Color Space

A different work color space (p.144) from the default settings (p.93) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.93), this default
setting will not be applied and the individually set color space will remain.

E\@/E The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Compositing Images

You can combine two images into a single image. You can further
combine images by adding another image to the composited image.
Since the composited image is saved as a separate image, the original
images remain as they are.

|§| This function can be used with all image types (p.3) supported by
DPP. However, images with more than 6666 x 4444 pixels are not
supported.

The color space of a composited image will be the color space of
the background image.

Image information is not appended to a composited image.

Select a background image in the main window.

You can also select a background image from the edit window,
edit image window, or [Collection] window.

Select the [Tools] menu P [Start Compositing Tool].

Start Quick check tool LHBF
Start Stamp tool L3S
tart Trimming/Angle Adjustment tool 3T
Start Compositing Tool WX
Start HDR Tool Y
Start Rename tool CHR
Start EOQS Utility X EE
Sync folder with EOS Utility
Transfer to Photoshop LEP

The compositing tool window appears.

HC.0 " IMG_0001.CR2 13456 % 2304]

1008 view

il SE
| Select an image

Composite Methnd
| Add

 TODO:RAWT S0Y &
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Select the image to combine.
Select the image to combine from the [Foreground Image] list

box.
l 100% view |

Select an image
¥ IMG_0001.CR2
IMG_0002.CR2

IMG_0004.CR2
IMG_0006.CR2

The selected image is displayed in the [Foreground Image]

thumbnail display.

A preview of the combined background image and foreground

image is displayed in the composite preview.

The following images can be combined.

* When a background image is selected in the main window
([Folder] window) or edit window: image in same folder as
background image

* When a background image is selected in the [Collection]
window: image in the [Collection] window

* When a background image is selected in the edit image
window: image displayed in the thumbnail display area

You can combine images of differing sizes.

Select a compositing method.

Select a compositing method from the [Composite Method] list
box.

[ 100% view ]

Foreground Image
| IMG_0002.CR2 54

(" Composte Method
¥ Add
Average
Weighted
Lighten

Darken

The compositing method selected in the composite preview is
applied.

The compositing method can be selected from five types: Add,
Average, Weighted, Lighten, and Darken. For details on each
compositing method, see “Compositing Methods” (p.81).

If you select [Weighted], you can set the proportion of brightness
of the image to be combined. Use the [Weight] slider at the
bottom of the [Composite Method] list box or directly enter a
value to set the brightness proportionally.

By clicking the [100% view] button, the image is displayed at
100% magnification (actual pixel size).
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Position the images.

CXals) || IMG_0001.CR2 [3456 x 2304]

' { 100% view |

| IMG_0002.CR2

Shift large amount (50 pixels)
Shift small amount (1 pixel)
Align image centers

You can also directly enter the position

coordinates of the [Foreground Image]
to align it.

By default, the background image and the [Foreground Image] are
displayed with their centers aligned.

[Compose in RAW Format]

Checkmark the [Compose in RAW Format] checkbox as necessary.

@ You can set [Compose in RAW Format] under the following @
conditions.
Both the background image and [Foreground Image] are RAW
images, and, all the following conditions are met.
» The cameras used to shoot were of the same model
» The ISO speed setting at time of shooting was the same
* The highlight tone priority setting at time of shooting was the same
» The image sizes (original size) are the same

The following functions are not available for images composited
with [Compose in RAW Format].

* Auto Lighting Optimizer (p.61)

* Picture Style Auto (automatically set to Standard) (p.59)

+ Selecting [Circle] for the aspect ratio when trimming (p.39)
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Click the [Save As] button.

Position
2
S
L« d]- D ]n]
v
3]
X o B 8
( Continue )
& Save As... J

By clicking the [Save As] button, the [Convert and save] window
(p-42) appears. Specify the required settings, and then click the
[Save] button.

By clicking the [Continue] button, images are combined to create
a new background image, and you can continue by combining
another image.

To finish, click the [Close] button.

Compositing Methods

Add

The brightnesses of the background image and [Foreground Image]
are added and images are overlaid.

Average

Images are overlaid with negative exposure compensation being
applied automatically. If you want to change the amount of exposure
for individual images, select [Weighted].

Weighted

Compositing method where brightness is set proportionally for the
[Foreground Image].

Lighten

The background image and the [Foreground Image] are compared,
with only brighter portions being combined.

Darken

The background image and the [Foreground Image] are compared,
with only darker portions being combined.

Creating HDR (High Dynamic Range) Images
You can create images with a wide dynamic range where clipping in
highlights and shadows has been reduced, and images that appear like
paintings. This is suited for scenes such as still-lifes and landscapes.
This function is most effective when using three images with different
exposures of the same scene (negative exposure, standard exposure,
positive exposure) to create an HDR image. However, you can also
create an HDR image from two images, or even only one.

Since an HDR image is saved as a separate image, the original images
remain as they are.

* HDR stands for High Dynamic Range.

|§| This function can be used with all image types (p.3) supported by
DPP. However, images with more than 6666 x 4444 pixels are not
supported.
Image information is not appended to an HDR image.

Select an image in the main window.

Dvgiial Phose Peodessional - | LG isers canon Pt s (Fheta xaxs_an us 1l
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Introduction
Select the [Tools] menu » [Start HDR Tool]. Specify the required settings, then click the [Start
HDR] button.
ann Select Images ) Contents at
Start Quick check tool NEF 1 a Glance
Start Stamp tool HS -/
Start Trimming/Angle Adjustment tool C#T I \
itinag Tool X 2
(" Start HDR Tool XY E SE———— Basic
= _— Operation
Start R I %R e |
art Rename too P e T
Start EQS Utility 3E
Sync folder with EOS Utility
_ IMG_D001.CR2 | IMG_0002.CR2 | IMG_0003.CR2 Advanced
ransier o PhOtOShOD - ki (_ Browse... ) ( Browse... ) ( Browse... ) operation
The [Select Images] window appears. &
You can also display the [Select Images] window from the edit
window and edit image window.

Start HDR

Advapced
Imag iting
and Pfinting

@ To change the selected image, or add another image, click the

[Browse] button and in the [Open] dialog box that appears, select Processing
the image file and click the [Open] button. Large Numbers
© If you select two images of the same size, you can checkmark of Images
the [Auto Align] checkbox for auto image alignment. However,
auto image alignment may not work properly with repetitive Editing
patterns (lattice, stripes, etc.) or flat, single-tone images. JPEG/TIFF
By clicking the [Start HDR] button, the [Adjust Image] window Images
appears.
@ After using auto image alignment, the periphery of the images is Reference
partially deleted. —
Index



Make required selections to adjust the image.

(. Yals] Adjust Image
Presets
| Natural 5
r e
Brightness:(55)
— 8|

| Saturation:(50)
—_— 00—

Contrast:(50)
—_—

.Dmil Enhancement
Strength:(0)

O
Smoothness:(0)

o—

Fineness:(0)

O——

Save As...

N/
IMG_0001.CR2/IMC_0002.CR2/IMG_0003.CR2

Sliders in [Adjust Image]
[Tone/Color]

[Brightness]: Adjusts the overall brightness of the image. Move
the slider to the right to brighten the image, and to
the left to darken the image.

[Saturation]: Adjusts the overall color saturation of the image.
Move the slider to the right to make the color
deeper, and to the left to make the color weaker.

[Contrast]: Adjusts the overall contrast of the image. Move
the slider to the right to make contrast stronger
and to the left to make contrast weaker.

[Detail Enhancement]

[Strength]:

Adjusts the overall contrast and contrast of

details together. Move the slider to the right for a

stronger effect.

[Smoothness]: Adjusts the overall smoothness of the image.

[Fineness]:

Move the slider to the right for a smooth and
natural impression.

Adjusts the clearness of details. Move the slider

to the right for a sharper outline.

[Presets] and finishing effects

With [Presets], you can select from the five preset finishing
effects below from a pulldown menu ([Natural] is selected by
default), instead of operating the sliders individually. By selecting
a finishing effect, each slider moves according to the setting. You
can also operate and adjust the sliders after selecting an effect.

[Natural]:

[Art standard]:

[Art vivid]:
[Art bold]:

[Art embossed]:

In high-contrast scenes, rendering in areas
where highlights or shadows are usually clipped
is corrected, for a finish with reduced highlight
and shadow clipping.

Gives a finish with painting-like tonality for an
impressive image.

For a more vivid look than with [Art standard].
For a more vivid look than with [Art standard],
that makes the subject pop out.

Tones down sharpness more than [Art standard],
for an old-fashioned feel.
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Click the [Save As] button.

By clicking the [Save As] button, the [Convert and save] (p.42)
window appears. Specify the required settings and click the

[Save] button.

Starting Up Map Utility

Map Utility is a software that allows you to view images shot on a GPS
function-compatible Canon camera, including the shooting location and
route travelled. After installing Map Utility to your computer, you can
start it up from DPP.

Select the [Tools] menu P [Start Map Utility].
Map Ultility starts up.
For information about Map Ulility, refer to the Map Utility
instructions, or to the Help for Map Utility.

® Do not edit images with DPP and use Map Utility at the same time.
Editing results may not be saved properly.

|§| > Version 1.1.0 or later versions of Map Utility are compatible.
® Map Utility is not included on the EOS DIGITAL Solution Disk.

© [Start Map Utility] will not appear in the [Tools] menu if Map Utility
is not installed to your computer.
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Printing with Shooting Information

You can freely lay out one image on one sheet of paper and print
together with titles and shooting information, etc.

Select one image to be printed.
Select the [File] menu » [Print with detailed setting].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

¥ IMG_0001.CR2

E Printer | Image Text Settings )
{

Printer :

[ Properties

Media
Ad

Media orientation 1‘
T Portrait
(O] Landscape

Media size:
297.0 mm x 209.9 mm

Print profile:

CMYK profile:

4 CMS settings...
o S

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.

For the shooting information, click [E]] on the [Text] tab sheet
and select the necessary items in the window that is displayed.

== To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.93).

If CMYK simulation has been set, the image is printed in the set
colors (p.93).
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

Select images to be printed in a thumbnail list.
Select the [File] menu » [Contact Sheet Prints].

Specify the required settings for printing, and then
click the [Print] button.
Switches the settings tab sheet

Contact Sheet Prints

1 printer Image = Text Settings

Printer :

Media :
A4
Media orientation:

) portrait
C Landscape

Media size:
209.9 mm x 297.0 mm

Print profile:

CMYK profile:

CMS settings...

Apply Cancel Print

Print preview

A/

== To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.93).
If CMYK simulation has been set, the image is printed in the set
colors (p.93).
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro, you can print with DPP by a simple
operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP, first install Easy-PhotoPrint Pro version 1.3 or later on
your computer.

Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].
Easy-PhotoPrint Pro starts up.

Match on-screen image colors and printing result

colors.
Select [Custom] in [Print Quality], click the [Set] button, and in the
window that appears, drag the slider to [1] at the right end, and
then click the [OK] button to close the window.
Next, click the [Color Adjustment] button to display the [Color
Adjustment] window and display the [Color Management] tab
sheet. Set [Color Mode] to [Enable ICC Profile] and [Printer
Profile] to [Auto], and then click the [OK] button to close the
[Color Adjustment] window.

Specify any other required settings for printing, and

then print.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.93) is not applied.

The printed image’s color is not what you expected

In the Easy-PhotoPrint Pro window, click the [Color Adjustment]
button to display the [Color Management] tab sheet, set [Rendering
Intent] to [Perceptual] (p.144), and try printing.

/

> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When a color space is set (p.77, p.93), it is automatically transmitted
from DPP to Easy-PhotoPrint Pro, allowing you to print with faithful
colors.

Printing with a wide color reproduction

When the color space setting (p.77, p.93) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider
color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format
imagePROGRAF printer. To print with DPP, first install imagePROGRAF
Print Plug-In for Digital Photo Professional on your computer.

Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for photograph
printing, and then print.

? Additional information

A single image can be printed at a time

You can print a single image selected in DPP at a time. When printing
multiple images, perform printing for each image individually.
Functions set in DPP that are not applied to printing

Specified output resolution (p.89) and CMYK simulation (p.93) are not
applied.

A/

-@> Advantages of printing with imnagePROGRAF Print Plug-In

Printing with faithful colors
When a color space is set (p.77, p.93), it is automatically transmitted
from DPP to the Plug-In, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.77, p.93) is set to a color space wider
than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.
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Specifying Preferences

You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.

Also, depending on the item, a detailed explanation may be available,
so refer to each window.

Select the [Digital Photo Professional] menu »

[Preferences].
The [Preferences] window appears.

Select the tab sheet, specify the settings, and then
click the [OK] button.

Preferences

([ General settings View settings Tool palette Color management ]

Startup folder

(*) Last displayed folder
() Specified folder

Browse... Canon 1/Users/Canonl/Desktop

Save recipe

() Display message when adding file
() Add to file automatically
Viewing and saving RAW images

(® High quality (recommended)
| View images at high speed (moiré reduction off)
View/save RAW images at high guality
Moiré is reduced and the NR tool palette can be used
JPEG image quality

| Remove block noise and mosquito noise

Default value of output resolution

330 dpif1-60000)

At EOS Utility startup

| Edit image window enabled at EOS Utility startup

—

Cancel A€ OK

General Settings

You can specify the folder that opens when DPP is started up, image
quality of displayed and saved RAW images, etc.

Preferences

[ General settings View settings Tool palette Coler management |

Startup folder

(*) Last displayed folder
() Specified folder

Browse... ‘Canon 1/Users {Canonl/Desktop

Save recipe

(*) Display message when adding file
() Add to file automatically
Viewing and saving RAW images
(®) High quality (recommended)
] Wiew images at high speed (moiré reduction off)
View/save RAW images at high guality
Moiré is reduced and the NR tool palette can be used
JPEC image quality

") Remove block noise and mosquito noise

Default value of output resolution

350 dpi(1-60000)

At EOS Utility startup

) Edit image window enabled at EQS Utility startup
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Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.62) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.62)
to reduce the luminance noise and chrominance noise.
Because the effects of the false color reduction processing and noise
reduction function are difficult to see in the [50% view] or [Fit to
window] display of the edit window and edit image window, use
[100% view] or [200% view] to check.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]
If you checkmark [View images at high speed (moiré reduction off)],
when the image is displayed in the edit window or the edit image
window, false color reduction processing is not applied. However, you
can use the noise reduction function.

As the setting is the same as [High quality] other than for image
display, the image undergoes false color reduction processing when it
is saved.

[High speed]
Since false color reduction processing is not applied, the display
speed of a RAW image in the edit window or the edit image window,
and the time it takes to save a RAW image is shorter than with [High
quality].
You cannot use the noise reduction function (p.62).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

® For images shot with ISO speed range expansion set, the difference
in image quality between [High quality] and [High speed] becomes
remarkable. To check the image quality of images shot with ISO
speed range expansion, make sure to set [High quality] and check
the images in the edit window or edit image window.

JPEG image quality

[Remove block noise and mosquito noise]
You can improve the quality of a JPEG image by reducing the noise
particular to JPEG images.
This setting is also effective when RAW images are converted to
JPEG images and saved (p.42, p.99) and for JPEG images that have
been saved with a different name.

? The extent of the improvement in noise reduction

The higher the JPEG image’s compression rate, the more noise is
reduced. When the compression rate is low, the effect of noise reduction
is negligible.

Default value of output resolution

You can set the resolution for RAW images converted and saved as
JPEG or TIFF images (p.42, p.99).
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View Settings

You can specify settings relating to the display.

Preferences

. General settings | View settings | Tool palette Color management

Grid pitch

64  Pixels(8-256)

Locking selected image

E Images opened in Edit window remain selected in main window

Magnification in Edit window

—

) Fit to window () 50% ) 100% () 200%

Magnification when the Edit/Edit image window is double-clicked

@ 50% () 100% ) 200%

RAW and JPEG

E Display only CRZ images for CR2 and JPEG files of the same name

Sort order in main window

™ Retain sort order

Highlight/shadow warning

Highlight 255 ez-255 [
Shadow o sy

Quick check tool display

& so% _) 100% (moiré reduction off)

( Cancel . e—

oK

Sort order in main window

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.21).

If you checkmark the checkbox, the order of the rearranged images is
maintained even if you quit DPP or select another folder in the folder
area.

If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you quit DPP or
select another folder in the folder area.

Highlight/shadow warning

Highlighted/shaded areas that exceed the set range can be displayed
on the image as warning indicators (p.55).
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Tool Palette

You can specify settings for the tool palette.

f. Il
Preferences

General settings View settings | Tool palette | Color management

Default settings of RGB Tone curve mode

Tone curve mode Tone curve interpolation method Histogram

" RGERGEB ® Curve

) Luminance R G B () Straight

(") Before adjustment
) After adjustment

Tool palette display in Edit Image Window
®) Docking display

) Floating display

Maodified Picture Style settings

E Retain settings of each Picture Style

Tool palette display mode

! Same for Main window and Edit window

Default noise reduction settings

@ Apply camera settings

() Set as defaults

RAW luminance noise reduction: )]

RAW chrominance noise reduction: o

TIFF{JPEG luminance noise reduction: O S

TIFF/IPEG chrominance noise reduction: om

¥ Cancel ] f OK -’

Default settings of RGB Tone curve mode

You cannot apply changes to the settings until you re-open the folder.

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings will be changed or retained,
when you change the Picture Style.
If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.
If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.

Default noise reduction settings

You can set a default beforehand for the noise reduction level.
RAW Images
* When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.
JPEG/TIFF Images
* You can set a desired default noise reduction level beforehand.
For images not having a recipe attached, the default set here for noise
reduction level is applied. However, if you want to apply settings to
images in the opened folder, you need to re-open the folder after making
settings here. For images with a recipe attached, the noise level
recorded in the recipe remains as it is and the default for noise reduction
level set here is not applied.

A/

=@> Advantages of setting a noise reduction default

In instances where the same level of noise occurs in several images,
such as images shot with high ISO speed, setting an appropriate default
noise reduction setting enables you to apply a batch noise reduction
default to all the images displayed in DPP (excluding images with a
recipe attached). This eliminates the need to apply noise reduction to
each individual image. And, since you always shoot with the same
conditions, it is also useful when you want to set the same noise
reduction level for all shot images.
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Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Preferences

+ General settings View settings Tool palette Color management }

Default settings of Work color space

Adobe RCB
Wide Gamut RGE
Apple RGB
ColorMatch RGE

CMM settings for print
For display :
%) sRGB

"~ Monitor profile
ENG/Library/ColorSync/Profiles/Displays/Acer AL1922-1CAB49E4.icc

Printing profile;

None -f]

Rendering intents:

CMYK simulation profile: Rendering intents:

None -f!

Rendering intents when using Easy-PhotoPrint
— Perceptual

{*) Relative Colorimetric

Cancel 3 f 0K 3

Default settings of Work color space

You can select from five types of color space (p.144) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.42,
p.99) or printed (p.43, p.46, p.49, p.85 to p.88).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the main
window (p.124, p.125), the edit window (p.127), and the edit image
window (p.133).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

|§| You can set a color space that is different from the default settings
for each image (p.77).

Display setting (color setting of the monitor)

Where a profile (p.143) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.
Select the [Monitor profile], click the [Browse] button and in the dialog
box that appears, select a profile for your monitor.

A/

5@3 Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.
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Setting of printing profile (color setting of the printer)

Where a profile (p.143) is attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile. The profile that has been set is applied to
all printing (p.49, p.85, p.86) except for printing using a Canon inkjet
printer (p.43, p.46) or linked printing (p.87, p.88).

? The adjustment function of the printer driver should not be
used

Even if you set a printer profile, if you use the color adjustment function
of the printer driver, the image may print in colors different from those
displayed on screen.

5\@/3 Automatic settings for printing using EPP EX, EPP, and
linked printing

If you are printing using a Canon inkjet printer (p.43, p.46) or using
linked printing (p.87, p.88), a profile is set automatically even when the
[Printing profile] setting is not performed. This allows you to print faithful
colors easily.

Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.144) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.124, p.125,
p.127, p.133) in the bottom of the main window, edit window and edit
image window, and colors can be checked.
To temporarily cancel CMYK simulation, press the <space> key.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.144) for printing
using Easy-PhotoPrint (p.46).

The rendering intent is ordinarily set to [Relative Colorimetric].

When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptuall.
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4 Useful Functions for Processing Large Numbers of RAW Images

For users shooting a large amount of RAW images, the convenient
function of batch processing large amounts of RAW images is explained
here.
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and

Introduction
? Additional information

applied to another image. Recipe data includes tool palette contents
o - . — . . . . . Contents at
You can edit images efficiently by selecting and adjusting one image Recipe data includes adjustments made with the tool palette ([RAW], a Glance
from images shot with the same shooting environment and batch [RGB], [NR/ALO] and [LENS]). For this reason, other editing content
applying the adjustment results to a large number of images. such as trimming or dust-erasure (copy stamp) is not included in the
o000 ¥ IMG_D001.CRZ reCipe data. Basic
- :[ e ) Recipes adjusted with the [RAW] tool palette can only be applied Operation
i (=] to RAW images
R _ Adjustments in the [RAW] tool palette, which can only be made for
ALy . a RAW images, are not applied to a JPEG or TIFF image even if they Advanced
@ i3 Register... Operatlon
Shot settings |3]|.{ Tune.. | are paSted
‘Piclure Style |_-1__-;-|| Advanced
Standard i‘]lF Browse... | Image Editing
- and Printing
Procg§sing
Larg bers
15 R e B Rt o o W e k of Im ges
Contrast: (]} T@T
Highlight: A e e = Ed_ .
. 0 Contents adjusted using the tool JPE(I_;t/I'r|']|gFF
b o palette can be handled Images
i L individually as a recipe file
Strength: ) e (extension “.vrd”).
;.mhm g _ Reference

Index

00

|§| The adjustment contents of JPEG or TIFF images (p.103) can be @
saved as a recipe file (extension “.vrd”) and loaded and applied to
another image in the same way as with RAW images.
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Introduction

Saving Recipes as a File

Select an edited image, and then select the [Edit]

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image. Contents at

menu » [Save recipe in file].
The [Save] dialog box appears.

Select the destination folder, enter a file name, and

and then select the [Edit] menu » [Copy recipe to Basic
then click the [Save] button. clipboard]. Oparation
The recipe is copied.
? Check the contents of a recipe file by pasting to an image Select the image to Whi_Ch the recipe is to be' applied Sg‘;?;‘ﬁﬁﬂ
o . _ and then select the [Edit] menu P [Paste recipe to
When you do not know the contents of a recipe file, paste it to an image g
T : selected image].

and check the settings in the tool palette. When only a few settings are W , , Advanced
adjusted, we recommend you use a file name that describes the The recipe is applied to the image. Image Editing
contents or that you separately record the adjustments as text and Printing

information.

Select the image from which a recipe is to be copied

a Glance

ProcegS§sing
Larg bers
of mes
Loading and Pasting Recipes -~
iting
Select the image to which a recipe is to be applied, J'T'E‘:"';':F
and then select the [Edit] menu » [Read and paste J
recipe from file].
The [Open] dialog box appears. Reference
Select a recipe and click the [Open] button.
The recipe is applied to the image.
Index

00
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific . :
shooting environment can be registered as personal white balance. You Applymg Personal White Balance

can then perform efficient white balance adjustment by applying this In the main window, select the image to which white
personal white balance to a large number of RAW images shot in the

same shooting environment.

Introduction

] ) Contents at
balance is to be applied. a Glance

Click the [Tool palette] button on the toolbar.

. - - The tool palette appears. Basic
Registering Personal White Balance paletic app e -ion

Click the personal white balance number button that
is to be applied.

Adjust the white balance (p.27, p.28, p.56).

To adjust white balance, select a setting other than [Shot Advanced
settings] from the [White balance adjustment] list box (p.27). You [ {_RAW.{ RGB  NR/ALO | LENS =t Operation
will be unable to register the adjustments if you select [Shot \Erishtﬂess adjustment ;?HJ‘
Settlngs]' ::||||||.||§|_||||||..n 0.0 Advanced
. : - - : Image Editing
In the [RAW] tool palette, click the [Register] button. [White bafance adjustment (=] and Printing
The [Register personal white balance] dialog box appears. [#] [‘ T3 glaegimr... Y
Select the button number to be registered from the P Y Tune. ) | Procogsing
. . ar ers
list and click the [OK] button. of Tl
8nn [#| Register personal white balance ‘Picmm s _,E’,,,
Register current setting in personal white balance Standard = ] [ Browse.. | Editing
- . JPEGITIFF
Current setting: Click white balance |mages
[ Custom 1 f :]]
| Cancel ) (F— —OK— —3
Reference
100 -30 -60 -4.0 -20 0 20 40
Contrast: ()] W
Highlight: (D ‘59 LA
Index
Shadow:

! Linear —

Color tone: M i i

Color saturation: 1) ..:...:....I.....e.l.............q

[ Unsharp mask Is @ @
Strength: YA Vi

98

Fineness:
Threshold:

® You cannot change or adjust white balance with multiple-exposure ] ) ) )
RAW images created on the camera. Personal white balance is applied to all the selected images.



Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Click the [Batch process] button on the toolbar
(p.124).
The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

Batch settings

IMG_0001.CR2 | Save folder

IMG_0002.CR2 ENG/Users /canonfDesktop (" Brow
IMG_0003.CR2
IMG_0004.CR2
IMG_0005.CR2 Kind of file | Exif-TIFF 8bit 5]
IMGA0U06ILRZ Image quality 1
IMG_0007.CR2

IMG_0008.CR2 Output setting

IMG_0009.CR2 _—

IMG_0010.CR2 Output resolution 350 dpi [ Embed ICC profile
IMG_0011.CR2 Resize setting

IMG_0012.CR2 [ Resize

IMG_0013.CR2 Width Height Unit
IMG_0014.CR2 343 2304 |
IMG_0015.CR2

File format

3456 % 2304
(3456 pixel ) (2304 pixel )
VL

File name_
@ Current file name
String

_ New file name
String Sequence number
DPP_ 0001
Ex.: IMG_000L.TIF, IMG_0002.TIF
Image transfer settings
| Open image using software

[ Browse...
P TR

Cancel ‘f Execute i'

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Terminate] button appears in
the batch processing dialog box.

In the processing dialog box, click the [Terminate] button.

? Saving images with recipe is not possible

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.41, p.119) to edited RAW images.

5\@/5 To save the developing/editing results for the version you are currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

@< skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the edit window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.

® If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected images.

@ If you have selected [New file name] in [File name], [Sequence
number] has to be set.
By saving as explained on this page, a trimmed image (p.38,
p.111) or dust-erased image (p.73 to p.77, p.114 to p.118)
actually becomes a trimmed image or dust-erased image.
For a list of [Batch settings] window functions, see p.141.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike
[Transferring a RAW Image to Photoshop] (p.77), you transfer images
that have first been converted and saved as a seperate image, so the
transferred image will not disappear after quitting the destination
software. The software used here as an example is Adobe Photoshop
CS.

In the main window, select multiple images to be
transferred.

Click the [Batch process] button on the toolbar
(p.124).
The [Batch settings] window appears.

Perform settings required for transferring (e.g. file
format).

Click the [Browse] button.

Batch settings

IMG_000L.CR2 Save folder

IMG_0002.CR2 MacOSX Users/canon/Documents { Erowse.. )
IMG_0003.CR2
IMG_0004.CR2

File format

IMG_0005.CR2 Kind of file Exif-JPEG i+
MECUANGICHS Image quality T 1 1
IMG_0007.CR2 ¥
IMG_0008.CR2 Output setting

IMG_0009.CR2

IMC_0010.CR2 Output resolution 350 dpi ¥ Embed ICC profile
IMG_0011.CR2 Resize setting

IMG_0012.CR2  Resize

IMG_0013.CR2 Width Height Unit
IMG_0014.CR2 3456 BN 2307

IMC_0015.CRZ {3456 pivel ) (2304 pixel )

v
File Name

"~ Current file name
String

@ New file name
String Sequence number

DPP_ 1 0001 - 1 __| Save sequence number
Ex. DPP_0001JPG, DPP_000Z.JPG

Image transfer settings
™ Open image using software

' ( Browse. \ '

Cancel ) (& Execute— )

The [Open] dialog box appears.

Select Photoshop CS.
In the [Open] dialog box, select a Photoshop CS file or an alias
and click the [Open] button.
The [Open] dialog box closes and [Image transfer settings] in the
[Batch settings] window is set to Photoshop CS.

Checkmark [Open image using software].

Image transfer settings

pen image using software

S - n
Adobe Photoshop C8 [ Browse... ]

F Cancel b ( Execute 3

Click the [Execute] button.
The processing dialog box appears and batch transfer begins.
When the first image has been transferred, Photoshop CS starts
up and transferred images are displayed in transferred order.

© If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected
images.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu P [Start Rename tool].
The rename window appears.

Specify the required settings (p.142) and click the
[Execute] button.

MacOSX/Users /canon/Pictures /Photo/xxxx_xx_xx

File Name Extension
DPP T Shooting Date/Time T‘ Sequence number L‘ Do not change L‘
Basic Settings Format settings

Sort Sequence number
@ Fit to main window 0001
; File Name
: Shooting Date/Time

" Save sequence number

Shooting Date/Time
‘i’ Month Day Year "!

__ Copy & Rename MM-DD-YY L'

MacQSX/Users /canon [Desktop @ Insert underbar

Original File Modified File Name

IMG_0001.CR2 | DPP_09-13-06_0001.CR2
IMG_0001,JPG U DPP_09-13-06_0002 JPG U
IMG_0002.CR2 DPP_09-13-06_0003.CR2

IMG_0002.JPG DPP_09-13-06_0004 JPG

IMG_0003.CR2 DPP_019-13-06_0005.CR2

IMG_0003.JPG — DPP_09-13-06_0006 JPG

IMG_0004.CR2 DPP_019-12-06_0007.CR2

IMG_0004.JPG DPP_09-12-06_0008 JPG

IMG_0005.CR2 DPP_09-13-06_0009.CR2

IMG_0005.JPG .| |DPP_09-13-06_0010JPG

€ -] B € >

75
I' Eancel

Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text has appeared in [Modified File Name], the file name
has been duplicated. Changes cannot be made if even one file name has
been duplicated. Change the settings so that duplication does not occur.

® The name of the movie files cannot be changed in DPP.

|§| You cannot start up the rename tool from the [Collection] window
(p.36, p.125).
For a list of the rename window functions, see p.142.

Changing the File Name of Images in the Order in the Main Window

When you change the order of the images in the main window, you can
change in one operation the names of the files for the images, in the
order they were rearranged.

Change the order of the images in the main window
(p.21).

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu P [Start Rename tool].

Select [Fit to main window].

MacOSx

File Name

DPP :. Shooting

Basic Settings

Sort

f*) Fit to main window ]
_ File Name

L

- Shooting Date/Time

Specify the required settings (p.142).
To copy an image, checkmark [Copy & Renamel].

Click the [Execute] button.

The file names are changed and the order in the main window is
maintained.

© If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected
images.
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5 Editing JPEG and TIFF Images

Introduction
DPP is software mainly aimed for advanced RAW image editing, but it —
also has JPEG and TIFF image editing functions. Here, the editing and
saving of JPEG and TIFF images are explained. C:rgfanr:‘s:eat
Editing JPEG and TIFF Images...........cccevveiieeenenes 103 1
About the RGB Tool Palette ............oovovverveerrerrenn. 103 | opeiction
Automatically Adjusting Brightness and Color (Tone -
CUNVE ASSISt) ...uvviiiiiiiieeeee e 104
Adjusting Brightness and Contrast ...........c..ccccco...... 105 ‘gg‘é*r‘:t?gg
Adjusting Color Tone Using Click White Balance..... 106
Adjusting Hue, Saturation and Sharpness................ 107
Tone Curve AdjuStment............ccovoveveveeeeeeeeeen. 108  |imageEditing
Adjusting Dynamic Range .........ccccccoeeviiiiiiiiiieennnnn. 109 and Printing
Reducing NOISE ..........oooviiiiiiiiii 110 X
. . : . Processing
Trimming and Adjusting the Angle of an Image..... 111 |Large Numbers
Performing Automatic Dust Erasure Processing ... 114 RS
Compatible Cameras...........ccoevevviieiiiieeiieeeeenn, 114 —
Automatic Dust Erasure Processing in the Main JPEElFF
WINAOW ..o 115 Im&Ges
Manually Erasing Dust (Repair Function).............. 116
Erasing Unwanted Parts of an Image (Copy Stamp Reference
FUNCLION).... e 118
Compositing and High Dynamic Range................. 118
Starting Up Map ULility ........ccooooeiiiiiii. 118 Index
Saving Editing Results..............cci 119 e’
Saving Editing Content to an Image......................... 119
Saving as a Separate Image .........ccoveeeeeeeereeeen. 119 @ @
Applying Editing Contents to Another Image......... 119
PUNGING oo 119 @
Re-Editingan Image.......cc.ccoooiiiiiiii 120
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/ALQO] tool palettes.

Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any number of
times.

8 8.8 ¥ IMG_0015.JPC
| RAW | RGB | NR/ALD LENS
Tl
| [ | [+ |3
Tone curve adjustment | & |
. HEB
"
255

Tone curve assist

N

ol

™ JPEG, TIFF im

| —
o 255
Brightness: L 01 —_—

Contents adjusted using the tool
palette can be handled
individually as a recipe file
(extension “.vrd”) (p.96, p.119).

Hue:

Saturation:

Sharpness:

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.119), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.96, p.119).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore, take care not to adjust your images to an
excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette.

However, for functions other than tone curve adjustment (p.108) and
automatic adjustment (p.104), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.143). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

[ 1

' RAW | RGB | NRJALO  LENS &

‘Tune Curve assist

[——Reverts the tone curve

Tone curve adjustment to the original settings
'''''' e r |G| & |
255 |- High
Standard
D 4
0 2535

Eﬂghtﬂess trrrnrerrYrrrrn e D\:t
Contrast: '———‘Q'———“ ol
trnrrrereYrner et L

T - Aoveos e
Hue trnrrrerereerrrenne |‘-?r‘: D‘:‘
Saturation: . 9 B 100 -

(AR EER SR ERERE R R — e

Sharpness: e—ibi 0 ?
TRLELER IR RN EE LRI R ot

The tone curve changes as adjusted.

|
\\/

== Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

» Images which have extreme backlighting

@ If you click the [[[Z%]] button, the tone curve as well as the [Hue]
and [Saturation] revert to the default settings. Take care when
adjusting the [Hue] and [Saturation] individually (p.107).

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editihg
JP IFF
| es

Reference

Index

00
©

104



Introduction
Adjusting Brightness and Contrast Brightness: Mgve the slider to the right to make.; an image
brighter and to the left to make an image darker.
The brightness and contrast of an image can be adjusted. Contrast:  Used to adjust modulation and degree of contrast Contents at
of color. Move the slider to the right to make a Glance

[RAW | RGB | NR/ALO  LENS | contrast of an image stronger and to the left to —

Tone curve assist 0Ol o+ 2o make contrast weaker.

‘Tcne curve adjustment b=} | BaSi(.:
L—J| Operation

m.jn BEEa .

255

Advanced
Operation

Advanced
Image Editing

and Printing
—_—

Processing
Large Numbers
of Images

Drag the sliders left or

0 255 | . E g
= right
B i i

Contrast: g*—l Enter numerical values

r——

Hue e rrnreYrnernnnnn |*2‘I D 'id
Saturation: '—@—[3] 100 : Reference

Sharpness: @—- | n
p (RN RN NN EJ D L e

Index

Q0

@ The adjustment range is —100 to +100 (in 1-stop increments when

entering a value). 105



Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[~]] button.

- RAW | RGB | NR/ALO LENS

‘Tnne curve assist 7] HE_'_ HED |
Tone curve adjustment L-i_-, [

Rjcfs]

o
[l |
w
LA

ErighmESS: trrrrrerrfrrrrn et
Contrast: "_@—
i rrereYrnerreent

Hue: ||||||||||E|||||||||| [EJ
Saturation: ||||||||||§|||||||||| E’J 100
Sharpness: Q—E‘]

[aw] (aw) (anl| [an] [a0]

=

(=]

Click on a point that is to be the standard for white.

annA | Digital Photo Professional - [ MacOSX,/Users [canon /Pictures /Photo/ xxxx_xx _ox /IMG_DD10.JPG | |

[iT67, 5471, 06282, 233

The coordinates of the cursor position and the RGB values (8-bit
conversion)

=» The color of the image is adjusted with the point you selected as
the standard for white.
If you click on another point in the image, the white balance is
adjusted again.
To finish click white balance, click the [] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

ﬁl The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.92).

J
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Introduction

Adjusting Hue, Saturation and Sharpness Hue: Move the slider to the right to make color tones
more yellow, and to the left to make color tones

You can adjust hue (tone) and saturation and make the overall redder.

; Contents at
atmosphere of an image harder or softer. Saturation: Move the slider to the right to make the color = (@l

deeper, and to the left to make the color weaker.
Sharpness: Move the slider to the right to make an image

[Fone cone oo (0] o+ oo harder, and to the left to make an image softer. OpBearzi?on

I

RAW | RGB | MR/fALO LENS

Tone curve adjustment B=3

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

- | E g
D s JP IFF
z | es
Eﬂ'ghmess: ||||||||||i|||||||||| D‘L‘
cuntraSt et rrnreyreernnnn Di’

Hue: [AREEN N mreen |3! D 2_ Reference
Saturation: (5] 100 3—} Enter numerical values

Sharpness: —— D] 0 ?——

[ (AR EA R AR NN -

Index

Drag the sliders left or right 2> Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]

or [200% view]. If the view is set to [Fit to window] (full view), the @ @

sharpness will seem unnatural.

|§| The adjustment range is —30 to 30 for hue, 0 to 200 for saturation, @
and 0 to 500 for sharpness (in 1-stop increments when entering a

value).
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.143).

Select the tone curve mode and interpolation

method.
| RAW | RGB | NR/ALO LENS - —
|Tone CUFVE assist e % ‘
Tone curve adjustment o] ‘
RGe | R [G |8 | B
755
v Curve
Straight
v RGERGB
Luminance RG B
il ul

]

Brightness:

Cantrast:

Hue:
Saturation:

Eharpness:

<control> + click inside
the graph to display the
menu

Make adjustments.

Batch adjusts RGB
Adjusts each channel

[

1~ RAW | RGE | NR/ALO LENS

|Tone CUrve assist J |

Tone curve adjustment

RGE ['[ch B )
755]

0

Brightness:

Cantrast:

Hue:

Saturation:

Sharpness:

Click to add a [[] (point)
Adjust by dragging [[]

The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [[]] is 8.

To delete a [[]], double-click on the [[].

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any

adjustments (p.92).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.92).
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Introduction

Adjusting Dynamic Range |§| The setting range of shadow points is 0 to 247 (in 1-stop —
Dynamic range (width of gradation expression) from dark points to bright increments when entering a value).
pgints in an image can be adjusted The setting range of highlight points is 8 to 255 (in 1-stop Contents at
' increments when entering a value). a Glance

The histogram display changes according to adjustment. You can —
also fix the histogram display to the display before any

Move downwards

Output highlight points adjustments (p.92). Basic
Operation
| RAW | RGB | NRJALO LENS b
‘Tcne Curve assist @@@
Tone curve adjustment - Jl-— Reverts the Advanc_:ed
W] o | c s | image to the Operation
Output ——f 259 Orlg_mal
highlight point settings Advanced
numerical Image Editing
value and Printing
Processing
Move to the — Move to the Large Numbers
right left of Images
Input shadow | Input highlight
points points Editihg
J JPﬁIFF
: 1 es
Outputshadow - ¢ J
pointnumerical 0 235 Input highlight
value E,,-ghmei,s; e — 0z | point numerical Reference
Contras '_@_‘ o value
Input shadow — e et e - : —
point numerical | Hue e ) of]
value Saturation: ..........@. S E’J 100 z Index
Sharpness: “”””_-””””““ 4| DE L
Move upwards
Output shadow points @ @
The horizontal axis shows the input level and the vertical axis shows
the output level. @
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Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have
been shot at night or with a high ISO speed.

Select the [NR/ALO] tab sheet from the tool palette in
the edit window or edit image window.

Click the [NR Preview] button.
|Naise reduction

RAW ﬁ NR Preview... |

The [NR Preview] window appears.

Adjust an image.

/NN NR Preview

Navigator
window

— Enlargement
display
TIFF/JPEG position

Luminance noise reducf
(01

Drag the
2 sliders

( Cancel ) ( Apply )

Chrominance noise redjgay
{0}

|
NR check window

You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.

Noise reduction is applied to the image and the image is
redisplayed.

ALy
N

- To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/ALO]
tool palette (p.129) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

|§| If [Luminance noise] has been set, resolution may be reduced
along with reduction of noise.
If [Chrominance noise] has been set, color bleeding may occur
along with reduction of noise.
You can set the batch processing settings for noise reduction
beforehand, using [Default noise reduction settings] in the [Tool
palette] tab sheet in the [Preferences] (p.92). This is particularly
useful for applying noise reduction to all the images in a folder at
once, such as batch noise reduction for images with high ISO
speeds. However, where images have a recipe attached, the
noise level recorded in the recipe is applied.
For a list of [NR Preview] window functions, see p.131.
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Trimming and Adjusting the Angle of an Image .
Introduction
You can trim only the part of an image you need, or change the Adjust the angle of the image as needed.
composition of an image where an image shot horizontally becomes Trimming/angle adjustment window
vertical. You can also adjust the angle of an image before trimming. If e
you select [Circle] for [Aspect ratio], the area outside the specified range C:’gfa"r:‘s:eat
will only be masked in black and the image will not be trimmed. Largest
--------------------------------------------- possible
Select the image to be trimmed. trimming Basic
range Operation
Open the trimming/angle adjustment window. ggf:te
Click the [Trimming Angle] button. image left Advanced
Digital Photo Professional - [ MacOSX /U / /Pi or I'Ight in operation
Igital Oto Froftessional - aCl sers/canon; Fic go_degree
\ \?3 f@ @ \ @ @ increments) Advanced
R-:l‘(l.;r.e ieft R-:l(;r.e right Q::ll:x E;arnp rn;::n-.mg 5 h B R e 1) Cancal @é Image E-diting
ok ' ) | and Printing
Drag® (0.01-degree increments; —
adjustment range: -45 to +45 degrees) A
Large Numbers
Use the mouse (click A/V) to adjust the angle or of Images
directly enter the adjustment angle* (0.01-degree
The trimming/angle adjustment window appears. increments; adjustable range: -45 to +45 degrees) E g
Editing can be done once the image is displayed clearly in the * You cannot adjust the angle of images that exceed 9999 x 6666 JTEE':F
trimming/angle adjustment window. pixels in size.
If you click [Center on Screen], you can display the trimming
range in the center of the window. Reference
If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range. e

|§| When aspect ratio information is attached to an image shot with the
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark lll,
EOS 5D Mark lll, EOS 7D, EOS 60D, EOS REBEL T4i/650D or
EOS REBEL T3i/600D, the trimming range based on the aspect
ratio information is displayed.

00
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Select a ratio and drag the trimming range.

ana = 171 IMG_0001 JRG (3456 x 2504]

Select a
trimming
ratio

Drag the
S—T— trimming

ATO4 IR0 < (226, 14030 = (1STT X OB 0900 e

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range. (Not available
when [Circle] is selected.)

List of aspect ratios (width : height)

11

3:2

2:3

4:3

3:4

5:4

4:5

A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

Circle
[Free]: You can trim an image to any size, regardless of the
selectable ratio.
[Custom]: You can trim an image at the specified ratio.
[Circle]: The area outside the specified range is masked in
black. The image is not trimmed.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.126).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.120).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.126).

+ Edit window:

+ Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate
image

The trimmed JPEG or TIFF image actually becomes a trimmed image
when saved as a separate image (p.119).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark I,
EOS 5D Mark Ill, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS
REBEL T3i/600D, the set trimming range based on the aspect ratio
information is displayed. Since the image is not actually trimmed, you
can change the trimming range or revert to the condition before
trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 5D Mark 1ll, EOS 60D, EOS REBEL T4i/650D
or EOS REBEL T3i/600D, its trimming range cannot be changed nor
reverted to the condition before trimming, since the image is actually
trimmed and saved in the set trimming ratio.*

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.135).

A/

The image is displayed in its trimmed condition.

* For JPEG images shot with EOS 5D Mark Il and [Add cropping
information] set in Custom Functions, aspect ratio information is
only set and the image is not actually trimmed.

Ay

> Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

@ For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

|§| For a list of the trimming/angle adjustment window functions, see

p.135.
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Performing Automatic Dust Erasure Processing S
The Dust Delete Data that is appended to images shot with the camera When the image has redrawn itself, click the [Apply
that can attach this data, can be used to automatically erase dust spots. Dust Delete Data] button.
‘B e Corgfnts at
. a Glance
Compatible Cameras T
Basic
EOS-1D X EOS-1D Mark IV EOS-1Ds Mark Il Operation
EOS-1D Mark Il EOS 5D Mark I EOS 5D Mark Il
EOS 7D EOS 60D EOS 50D Advanced
EOS 40D EOS REBEL EOS REBEL R
T4i/650D T3i/600D
EOS REBEL EOS REBEL EOS DIGITAL REBEL I Advaélg_et_d
T2i/550D T1i/500D XSi/450D and Printing.
EOS DIGITAL REBEL EOS REBEL EOS DIGITAL REBEL s s
XTI/400D DIGITAL  T3/1100D XS/1000D »Dust spots are erased in a single operation. L;_gzcﬁjrsnigg,s
In the main window, select an image appended with Click the [OK] button to return to the main window. Slllaes

Dust Delete Data.

] spots have been erased. JIE ﬁ:F
Click the [Stamp] button. Imd#Ges
Digital Photo Professional - [ MacOSX /Users/canon/Pic
Reference
—_
Index
—_—

The copy stamp window appears.

=>The [8,] mark (p.126) is displayed on an image from which dust

® Dust Delete Data is not attached to images having settings specified

during RAW processing on the camera for distortion correction,
chromatic aberration correction, etc. As a result, you cannot perform
automatic dust erasure processing on such images.
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? Additional Information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.120).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust

erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.116) or the copy stamp function (p.118).

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.119).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, see p.140.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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L 15 e e e s s

The display changes to 100% view.
The display position can be changed by dragging.

Manually Erasing Dust (Repair Function) .
Introduction
You can erase dust spots in an image by selecting them one by one. Click the button that matches the dust spots to be
— ) erased.
In the main window, select the image you want to If the dust spot is dark in color, click the [ @»() [] button, and if Contents at
erase dust spots. the dust spot is light in color, click the [ {_»()[] button. a Glance
. { )
Click the [Stamp] button. When you move the cursor over the image, the dust erasure
range appears as [O]. Basic
Digital Photo Professional - [ MacOSX /Users/canon/Pic Place the dust SpOt to be erased within the [O] and Operation
DD ® & 2 click. —
. \ . S N s e
otate | Rotare right Oaick Sramp Elmming Barch Advanced
Operation
== - : Advanced
O - Click Image Editing
] it : and Printing
The copy stamp window appears. = —
When the image has redrawn itself, double-click the Processing
. . Large Numbers
point from where dust is to be erased. of Images
d Eqgmo
=5 : JP§IFF
| e : e 1 es
: The dust spot within the [Q] is erased.
Click on another part of the image to continue erasing dust spots
Double- in the image. Reference
click To erase dust in another part of the image, click the button —
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3. Index
When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.
The [@,] mark (p.126) is displayed on an image from which dust
spots have been erased.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.118).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.120).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.119).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <3B> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <shift> key, and then displaying the copy
stamp window.

® For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

|§| For a list of the copy stamp window functions, see p.140.
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Compositing and High Dynamic Range .
Introduction
: : You can composite images also using JPEG and TIFF images in the
Erasing Unwanted Parts of an Image (Copy Stamp Function) same way as RAW images as described below,
You can correct an image by pasting a section copied from another part Compositing Images (p.78)
fthe i to an unwanted part of the image ' i i Contents at
or the image unw p Image. Creating HDR (High Dynamic Range) Images (p.81) a Glance
Follow steps 1 to 3 in “Manually Erasing Dust (Repair
H LH - mgm B .
Function)” (p.116). Starting Up Map Utility -t
Specify the section to be copied. You can start up Map Utility using the procedure below.
Click on the section that is to be the copy source while holding Starting Up Map Utility (p.84)
down the <option> key. Advanced
] ] Operation
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy Advanced
Source position]. '?:(?%Eg;f%g
Correct the image.
Click or drag on the section you want to correct on the image. [+] Processing
. . - - Large Numbers
in the window indicates the copy source and [Q] indicates the of Images

copy destination.
The copied image is pasted in the position to which it was

Editihg
dragged. JP'%IFF
For [Pen type], you can select from [Brush] (the pasted image’s Im#Ges
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Reference
Click the [OK] button to return to the main window.
The [8,] mark (p.126) is displayed on a corrected image.
Index
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Saving Editing Results

Saving Editing Content to an Image

All the contents (recipe) adjusted with the tool palette (p.103 to p.110)
as well as the trimmed range (p.111) and dust-erasure (p.114 to p.118)
information can be saved to a JPEG or TIFF image, or to a separate
JPEG or TIFF image.

Select the [File] menu » desired item.

Open in Edit window FO
Open in Edit window (enlarged)

Close window W
Save #5

Save As... 1+ 3#S

Add thumbnail to image and save {r38T
Convert and save... #*D
Batch process... #B

Create new folder... {r 3N
Page setup... {r 3P

Print... #P

Print with detailed setting... {+ 3D
Contact Sheet Prints... ~HP

Plug-in printing >
Add to collection ®G

Remove from collection 3G

Clear collection

Delete 3 <
Info... 1

Your adjustments are saved to the image.

Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.103 to p.110)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.111) or dust-erased image (p.114 to
p.118) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.42)

Batch save as JPEG or TIFF images (batch processing) (p.99)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.41)

Utilizing adjustment contents (recipe) (p.96)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.43)

Printing with shooting information (p.85)

Printing a thumbnail list (contact sheet printing) (p.86)

Printing RAW images on a high-end Canon printer (p.87)
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.103 to p.110), so the “original image data itself”
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.111) or dust-erased image (p.114 to
p.118) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.119) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Adjustment

Rotate left L
Rotate right 3R
Apply Dust Delete Data

Work color space >

Tone Curve Assist - Standard
Tone Curve Assist - High

Revert to last saved settings “_3Z
Revert to shot settings ~¥Z

The image reverts to the conditions of the selected item.
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Reference

This reference section has been provided to enhance your experience
using DPP.
It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.

B An Index is provided at the end of the chapter for you to easily find
information you are looking for.

Troubleshooting..........coiiiiiiiiiiii e, 122
Deleting the Software (Uninstalling) .............cc....... 123
List of Main Window (Folder Window) Functions .. 124
List of Main Window (Collection Window) Functions... 125
Image Frame Information in the Main Window and Edit

Image Window ..o 126
List of Edit Window Functions ..........cccooovivvieniennnnn. 127
List of Tool Palette Functions ..........ccccovvvvvvenrennnenn. 128
List of NR Preview Window Functions................... 131
List of Quick Check Window Functions ................. 132
List of Edit Image Window Functions .................... 133

List of Convert/Save One Image Window Functions ..... 134
List of Trimming/Angle Adjustment Window Functions.. 135
List of Lens Aberration Correction Window Functions... 136
List of Digital Lens Optimizer Adjustment Window

FUNCLIONS ..., 137
List of Compositing Tool Window Functions............... 138
List of HDR Window (Adjust Image) Functions ..... 139
List of Copy Stamp Window Functions.................. 140
List of Convert/Save Multiple Images Window (Batch
Processing) Functions..............ccccceeiiiiiiiiiieeceeees 141
List of Rename Window Functions........................ 142
(€110 115 143
INAEX .. 145
About This Instruction Manual.............................. 149
Trademark Acknowledgments.................cc........... 149
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges. For how to log in and how to specify
Administrator settings, refer to the User’s Manual for the Macintosh
computer you are using or for OS.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements are not met. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Quit
any applications other than DPP.

The card reader does not detect the SD card.

Depending on the card reader and computer OS used, SDXC cards
might not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility (provided software).

Images do not display properly

Images that are not supported by DPP do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than
Exif compatible images may not display properly (p.3).

When a dust-erased image (p.73 to p.77, p.114 to p.118) is displayed
in a window other than the copy stamp window, it is displayed as it
was before dust erasure was performed. Check dust-erased images
in the copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.128).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.10, p.25, p.124, p.132, p.133),
trimming (p.38, p.111), dust erasure (copy stamp) (p.73 to p.77, p.114
to p.118) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.128).

The Auto Lighting Optimizer (p.61) is a function that is only available
for RAW images shot with EOS-1D X, EOS-1D Mark IV, EOS 5D
Mark 1ll, EOS 5D Mark Il, EOS 7D, EOS 60D, EOS 50D, EOS REBEL
T4i/650D, EOS REBEL T3i/600D, EOS REBEL T2i/550D, EOS
REBEL T1i/500D and EOS REBEL T3/1100D. You cannot apply the
Auto Lighting Optimizer’s adjustment contents to RAW images shot
with other cameras.

Color appears weak in the image when viewed with
other software

A RAW image which has a color space other than sRGB set (p.77,
p.93) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with sSRGB color space. In this case, set the RAW image color space
to sRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.93) and a profile for a printer is
set up correctly (p.93), the color of a printed photograph and the color
of an image on screen can be more closely matched. Using a Canon
printer (p.43, p.46) or linked printing (p.87, p.88) automatically sets up
printer profiles, so you only need to set the color of the monitor to
bring the colors closer together.

When printing using Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.47).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.49).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with EOS 10D and EOS
DIGITAL REBEL/300D DIGITAL may not display image information
(p.10, p.23).

Deleting the Software (Uninstalling)

Quit any applications before uninstalling the software.

Log into the account used when installation was performed.

When you have moved the folders and the software to be deleted to
the Trash, select the [Finder] menu » [Empty Trash] and empty the
Trash. You cannot reinstall the software until you have emptied the
Trash.

Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

Address Book Automator Calculator Canon Utilities

®

DVD Player Font Book Front Row

60

Photo Booth Preview

QuickTime Player

®m o

System Preferences TextEdit Time Machine Utilities Open in Finder

Drag the folder for the software to be uninstalled to
the Trash.

Select [Finder] menu on the desktop » [Empty Trash].

The software is deleted.
When uninstallation ends, restart your computer.

@ You cannot retrieve data that you have emptied into the Trash and
deleted, so be particularly careful when deleting data.
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List of Main Window (Folder Window) Functions .10

Introduction
Shows/hides the tool palette (p.128) Image information (p.23) Cancels selection of all images Displays the trimming/
Shows/hides the folder area Selects all images Displays the quick check window (p.132) angle adjustment
Switches to the editimage ‘ Displays the copy stamp window (p.140) v‘vnndow (p-135) Contents at
window (p.133) 1 , , , a Glance
@| Digitil Photo|Profi | Fil§ Edit |View Bookmark Label |Adjustmlent Tpels Window Help E 4 Wed 10:48 AM Q 1
Digital Photo Professipnal - [ MacOSX/Users/canon/Pictures/Photo/xxxx_xx_xx ] F0|der path —
Toolbar*? Batch conversion/
versi :
[Collection] tab sheet*® : o saving OpB;z;?on
[Folder] tab sheet*> ___Folder Collection(0) i (p.99, p.100, p.141)
vf‘”‘:a;g;ﬁca(ions : ; " : 1‘ '”; ’ ’
[ Temporary ltems . — . |Image rotation
T 2 (90 Scgjegree units) Advanced
¥ [ Desktop e Operation
Check mark (p.19) W
iy
% e m:;mm e e = oo Bl come | wose Rating (p.19) Advanced
v [ Pictures * Image Editing
VL;L'??:)(:(,xx,xx - and Printing
» [ Shared Processing
Large Numbers
Folder area*? . r of Images
IMGON06CRZ _i@m . MGOODZCRZ MGODDECRZ gy IMG_ODDICRZ IMG_D010.CR2
Editing
JPEG/TIFF
Images
. & o B Reference
;Aduhgllﬁﬂ]Aduhe RGB High quality Re:ipelda(a: Yes Numbarlal images: 15 Numberlofselnnnd images: 1 CMYK ,,f_— CMYK Simulation
| | ispl 93
Image color space and workJ Display mode** ‘ Number of selected images display (p.93)
*3
color space™ (p.77, p.93) Recipe attachment status (p.96) Number of displayed images @ @
*1 To switch between show/hide, select the [View] menu » [Toolbar]. *4 The item selected in [Viewing and saving RAW images] (p.89) of the @
*2 The images inside the folders selected here are displayed in a [Preferences] window is displayed. ~
thumbnail list on the right. *5 You can switch between the [Folder] and [Collection] windows.

*3 Displays the coordinates of the cursor position and the RGB values (8-bit
conversion) when click white balance was performed with the tool palette. 124



List of Main Window (Collection Window) Functions 39

Image information Cancels selection of all images

Selects all images

Shows/hides the tool palette Displays the quick check window

Displays the copy

Sywtches to the edit image ‘ stamp window
window ,|
@ Digital Photo|Profi | Fil§ Edit |view Bookmark Label [Adjustnjent Toels Window Help E 4 Wed 9:46 AM Q
N Digjital Photjo Professional - [Collection]
Toolbar .
. 1 Batch conversion/

[Collection] tab sheet 7 saving
[Folder] tab sheet Folder

— Displays the trimming/
angle adjustment
window

— Rating

.......... am  NCOWECR e

— Image rotation
(90 degree units)

— Check mark
Adobe RCE / Adobe RGE High quality Recipe data: No Number of images: 7 Number of selected images: 0 vk 7 B CMYK simulation
| | displa
Image color space and woer Display mode Number of selected images play

color space*? (p.77, p.93)

Recipe attachment status Number of displayed images

*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion) when click white balance was performed with the tool
palette.

*1 The total number of images added to the [Collection] window is
displayed in the (') in the [Collection] tab sheet. Accordingly, when an
image is added that is displayed as a single image (p.22), twice the
total number of displayed images is displayed.
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Image Frame Information in the Main Window and Edit Image Window (.10, p.34) e
Information displayed when [Large thumbnail] (p.10) is selected
[ M N Digital Photo Professional - [ Canon 1/Users /Canonl/Desktop/xxxx_xx_xx ]
Contents at
D (o (@ ® O (B 8 & 7 . —
Digital Lens
Optimizer mark Basic
Folder Collection(0) (p-69t0p.72) R
Check mark v MacOSX__ 1
(p.18, p.19) rAppltions Copy stamp Advanced
= Temporary Items L mark Operation
¥ [& Users (p.73 to p. 77,
v @ canon p.114 to p.118)
¥ [@F Desktop Advanced
" Travel I Lens Image Editing
aberration and Printing
Rating mark P IF Documents correction
(p18, p19) b & Library mark (p65) :
[= Movies Tri L:rocrﬁssgg
, B Atiacir | Trimming rge Numbers
Brllghtness -"f_!---- range* of Images
adjustment ¥ i Pictures
*1 v [ Photo (p.38, p.111)
value™' (p.26) L e 613 | = | Aperture*? Editing
o — (0] dokk 11400 (] [1/400] JPEGITIFF
= 8. Flihlle R+3 IMC_0001CR2 . raw B IMC_0002.CRZ GPS Images
White balance icon*! (p.27) File name GPS mark*> Reference
Unsaved editing content mark
Image type*? Shutter speed*3

*4 When aspect ratio information is attached to an image shot with
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark IIl, EOS-1D Mark I,
EOS 5D Mark Ill, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS
REBEL T3i/600D, the image is displayed as a trimmed image.

*5 Displayed on images shot on a GPS function-compatible Canon
camera.

*1 Does not display with [Small thumbnail].

*2 Displays in RAW+JPEG images displayed as a single image (p.22).
[RAW] is displayed in RAW images.
(In [Small thumbnail] (p.10), [R] is displayed.)

*3 Does not display with [Medium thumbnail] or [Small thumbnail].

e
00
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List of Edit Window Functions .11, p.25

Path and file name of image

Tool palette*' (p.128, p.129, p.130)

ane 1! Digital Photo Professional - [ MacOSX fUsers/canon/Pictures /Photo/xxxx_xx_xx /IMG_0001.CR2 ] i) & & & }jf IMG_0001.CR2
|———{ RAW | RGB NR/ALO LENS i
|Erighmess adjustment - ‘

( 918, 1282 ): 75,‘81., 93 RAW ﬂlAdubE RGE CN!YK High qu:i\lt\! ,%J

Display mode**
CMYK simulation display (p.93)
Image color space*3 and work color space (p.77, p.93)

Information display*2

|While balance adjustment

o A

Shot settings

| Picture Style lil‘

Standard 1+ (" Browse.. )

o T g

Cantrast: 10 T@T
Highlight: L S s
Shadow: (st s
) Linear
Calor tone: ] T@T
Color saturation: 0 T@T
Unsharp mask ks
Strength: 101 e“|||||\|l
Fineness: 10) m
Thrashold: 0 S

*1 To switch between show/hide, select the [View] menu » [Tool palette]. *3 RAW images are displayed with [RAW].
*2 Displays the coordinates of the cursor position and the RGB values (8- *4 The item selected in [Viewing and saving RAW images] (p.89) of the
bit conversion). [Preferences] window is displayed.
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* If an image is displayed enlarged, the enlargement display position can be
moved by dragging. The enlargement display position appears when
[Docking display] (p.92) has been set and the edit image window (p.133)
has been enlarged.

List of Tool Palette Functions .
Introduction
RAW Tool Palette (p.25) RGB Tool Palette (p.60) —
S & & %} IMG_00D01.CR2 ] e & ¥ IMG_0001.CR2
|—[ RAW | RGB NR/ALO  LENS | | | [ "RAW | RGB | NR/ALO  LENS | Automatic adjustment C:'gfanr::(s;eat
Brightness adjustment laj . . Tone curve assist L@w.’— tone curve aSSiSt 33’ 104
——— Brightness adjustment (p.26) [Frs v s a ( ) (P P ) -
— = e < | c | s | A Click white balance (p.106) Basic
s 255 =
4 o rii‘ﬂi'— ——— White balance adjustment Operation
: Shot settings Iv'] Tune... jj (p27, p28, p56) | Tone curve adjustment
|PictureSter =) || i i (p58’ P ! 08) Advanced
—‘]-— Picture Style settings (p.26, p.59) Operation
andard 5 rowse. .. . .
\ = )Ce = - Dynamic range adjustment (p.109)
: Advanced
A : L Dynamic range adjustment (p.57) Image Editing
5 ' and Printing
| 150 50 %0 -a0 20 BT ) _ - ; =
e ) ey — Contrast adjustment (p.29) L = = Brightness and contrast L:roc§SSigg
Highlight: st o ) s . . . 4 S e = ; rge Numbers
e i ._é Shadow/highlight adjustment (p.57) | contrast 5 38 adjustment (p.105) 9 Images
L Linear - Linear setting (p.29) Hue: e el ol . ,
E::Z:‘:‘:ﬁm IE: el Color tone and color saturation Saturation: o o e LD © Hu1eoa7nd Saturation adjustment Editing
e e B 8- AR adjustment (p.29) Sharpness: e ) (p- ) JPEGI/TIFF
|
sl b TITIT : Sharpness adjustment (p.107) i das
Fineness: {0y E— Sharpness adjustment (p.31)
Threshold: {0) m J ‘
Sharpness I ] R e Reference
Sharpness: i m] I !
Enlargement display position* ——— Enlargement display position* “
£)
—
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NR/ALO Tool Palette

(When a RAW image is selected)

& &6
[

4% IMG_1001.CR2
RGB | MRfALO

)

RAW LENS

IAr.ltn Lighting Optimizer

B —

L Low  Standard  Streng

- Auto Lighting Optimizer (p.61)

|Noise reduction

RAW

__seeh__ri—— Apply noise reduction button (p.62)
~ nreeview. - Displays the [NR Preview] window

(p.62, p.131)

[ Luminance noise reduction

{?] n |...|E|...||.|| 20

J— Luminance noise reduction for

RAW images (p.62)
——— Chrominance noise reduction for

8 o T,
_TIFF/JPEG

Luminance noise reduction

(0 0l & 20

Chrominance noise reduction

(0 o 20

RAW images (p.62)

——— Enlargement display position*

* Ifanimage is displayed enlarged, the enlargement display position can
be moved by dragging. The enlargement display position appears
when [Docking display] (p.92) has been set and the edit image window

(p.133) has been enlarged.

NR/ALO Tool Palette

(When a JPEG or TIFF image is selected)

8 &5
[

¥ IMG_1001.JPC
RCB | NRfALO

i

RAW LENS

| Auto Lighting Optimizer

Low  Standard Strong

|Noise reduction

__asoy i Apply noise reduction button (p.110)

RAW [ nrepeview. J———— Displays the [NR Preview] window
Luminance noise reduction (p1 107 p1 31)
(0 o & " m
Chrominance noise reduction
(0 0 E—2R = 20
TIFF/JPEG
[ Luminance noise reduction ]— Luminance noise reduction for
R — 2 ) JPEG and TIFF images (p.110)
m o =% » | Chrominance noise reduction for

JPEG and TIFF images (p.110)

——— Enlargement display position*
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LENS Tool Palette

8O0 # IMG_1001JPG
| RAW RGB  NR/ALO | LENS |
g 4l Lans U Umiee TweH—— Digital Lens Optimizer adjustment button (p.71)
Setting OFF —— Amount of Digital Lens Optimizer (p.70)
Lens data Yes —— Lens data status (p.70)
[ update.. +—— L ens data Update button (p.70)
Bl ot __Twe.. Hi—— Lens aberration correction adjustment button (p.65)
Peripheral illumination OFF
Chromatic aberration QOFF
Color blur OFF —— Lens aberration correction (p.65)
Distorticn OFF
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List of NR Preview Window Functions .62 p.110) .
Introduction
Contents at
('B' Y NR Preview : a Glance
Basic
Operation
Enlargement displa
Operation
Navigator window
Advanced
Image Editing
Image type* and Printing
k|
Luminance noise reduction = ) . .
[{m d S > 5 Lummgnce noise Processing
(IRRRRP . LI RARRRREaL! 5 redUCtIOn LargeNumbers
Chrominance noise reduction ) i ) of Images
o 0.8 20! Chrominance noise
L I L L I 01 0 O 1 I O 8 '-4_ redUCtlon T
. . Editing
( Ccancel ) € Apply 4| Apply noise reduction JPEG/TIFF
button Images
8 P

Reference

e
00

NR check window

* When you select a JPEG or TIFF image and display the [NR Preview]
window, [TIFF/JPEG] appears and you can reduce luminance noise
and chrominance noise for the JPEG and TIFF images.

5,

131



List of Quick Check Window Functions (.15, p.18)

50% view/100% view (moiré reduction off)/full view*'

Check marks (p.18)

File name of image

2/15 IMIG_DDGZ.CRZ [3456 x 2304]

\
| 50%view H Full screen I—

Check mark

l12345|

Clear —

Rating

[ Reject

— Displaystheimage
in full screen*?

| Removes check
marks (p.18)

— Rating (Reject) (p.18)

L Rating (p.18)

( Pre\lrious ) (

T IAF Paint

Next )

Switches between
displayed images

[ Image Information I

[——

( Rotate left ) [ Rotate right )

Displays the AF
points (p.16)

— Displays the image
information window
(p.24)

Image rotation
(90 degree units)

*1 You can select 50% view/100% view (moiré reduction off) by selecting
[Preferences] in the [Digital Photo Professional] menu and using
[Quick check tool display] in the [View settings] tab sheet. You can
also move the display position in the enlarged display by dragging the
image.

*2 To return to the normal screen, press the <esc> key.

J
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List of Edit Image Window Functions (.34, p.36)

Shows/hides tool palette Image information (p.23)  Enlargement ratio of displayed image Displays the trimming/

Shows/hides thumbnail display area Shows/hides grid*4 Displays the copy stamp window an%ISe adj1u1s1tmer11t3vg/indow
Switches to main window ‘ (p.73 to p.77, p|-1 14 to p.118, p.140) (p.| P P199)
(p124) ||. Digitjl Photo|Professjonal Fflile Edit View Label Adjustment Tools Window Help E 4 Thus:ldpM @ l Image path and

li Digital Photlo Professional - [ ENG/Users/canon/Pictures/Photo/xxxx_xx_xx/II1G_0003 |CR2 |

file name

Batch conversion/
saving

(p.99, p.100,
p.141)

Image rotation

Toolbar

{ RAW | RGB NR/ALO | LENS —\

‘ Brightness adjustment =) ;‘

‘wmle balance adjustment =) ;‘

] 1 | (90 degree units)
Shot settings 1 Tune ).

—— 5 Switches between

Standard 1) ( Browse.. ) dlsplayed Images

- Tool palette
(p.128)
-10.0 -8.0 -6.0 -40 -20 0 2.0 44

. . *3 Contrast: 10 -.“-"@T
Thumbnail display area™ —| A o
Shadow: (O} E
Color t:rl.’:a’ (o T
Color saturation: 10 —IT@T
Strength 10 W
s (e —
Thresheld 1o Q'_H_—.

® et
e IMG_0005.CR2

Informatlon dISpIay*2 L(1114,1304) 113, 132,172 RAW j Adabe RGB CMYK — _High quality 1 7

Image color space*! and work color slpace C|MYK simulation display (p.93)
(p.77, p.93)
*I RAW images are displayed with [RAW].
*2 Displays the coordinates of the cursor position and the RGB values
(8-bit conversion).
*3 Displays images selected in the main window. The image selected
here is enlarged and displayed on the right.

Display mode*®

*5 The item selected in [Viewing and saving RAW images] (p.89) of the
[Preferences] window is displayed.

*4 You can set the grid spacing with [Grid pitch] in the [Preferences] (p.91).

J
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List of Convert/Save One Image Window Functions (.42

Convert and save

| File name
Save As: DPP_001 | [+]
Types of image _
- 5 Where: ' [T Photo | :% Save destination
Type of image Extension -
Exif-JPEG JPG File format
Exif-TIFF 8bit TIF } : _

TIFF 16bit TIE Kind of file Exif-JPEG [ ,]
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG Image guality S T7 JPEG compression rate*3
TIFF 16bit+Exif-JPEG | .TIF/.JPG Embeds of ICC profiles*2 (p.143)

Qutput setting

Qutput resalution 3!50 dpi

Resolution*1

"1 Embed ICC profile

( Resize setting > B W \_ p
| Resize
Size changing*4 Width Height Unit -
3504 w 2336 pixel =
{3504 pixel ) {2336 pixel ) y 7
f Lock aspect ratio
L J

I\ Cancel JI { Save }f—save

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.77, p.93) information that is set in an image is attached
to an ICC profile.
Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.77,
p.93), the ICC profiles are embedded automatically.

*3 The setting range is 1 to 10. The higher the numerical value, the higher
the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the
longer edge of an image and change its size.
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List of Trimming/Angle Adjustment Window Functions (35 p.111) e
Cancels all the trimming (aspect ratio) information
Glala [# 1/1 IMG_0001.CR2 [3456 x 2304] , Full screen display/returns to normal screen
[ Full scréen ] Contents at
" . a Glance
Clear reset ——{—— Reverts to the condition when the image was shot
pm e ~:  [— Ratio of trimming range (you can also enter
s K> 00 numerical values if you have selected [Custom])*" Basic
: / ) . Operation
[* e J— Upper left coordinates of trimmed range (you
\:.3; 0 ::;:m- o can also enter numerical values)
[lm - m 8 }_ Eszrﬁe(ﬁ c};llnz/r:lﬁg Sr)ange (you can also enter ‘8 dvanced
|8 . . ti
| [’“"9"‘- 1":0 v )— Angle of image adjusted e
" - = S N (Drag bar, use the mouse to click A/V or enter
numerical values to set angle) Advanced
¥ J— Copies the trimmed range and applies (pastes) Image Editing
3 it to another image*?2 and Printing
== —Applies the copied trimming range to all other
g e images™? Processing
L Qi i ; *2 Large Numbers
- Switches between displayed images of Images
e = Level of opacity outside a trimmed range
[cﬁd pitch —— Shows/hides grid lines . Jfggﬁﬁ:F
& e (Drag bar to set distance between grid lines) Images
{ Center on Screen 1
| Displays the trimming range in the center of the
{Cancel JSSORSSE window Reference
L (704 ,362)->(2281,1413)= (1577 x 1051)[ 1.50] %"

Trimming range Displays borders around a trimmed range

Image rotation (90-degree increments)

00
)

135

*2 Qperates when you have selected multiple images and the trimming/
angle adjustment window is displayed.

*1"f [Free] has been selected in the [Aspect ratio] list box, you can also
drag the borders of the trimmed range to change its range.



List of Lens Aberration Correction Window Functions (.65 oo
When the list box for selecting an extender is displayed in the To correct distortion aberration of images shot with a fisheye lens,
[Lens aberration correction] window, select the extender four effects can be selected from the [Effect] list box in addition to
attached at the time of shooting from the list box. [Shot settings] normally used for distortion correction. Contents at
(® N Lens aberration correction - [IMG_0001.CR2] ] a Glance
, . Basic
Operation
—Enlargement display section*’
Advanced
Operation
" Reset .| Revertstothe condition when the Advanced
S— image was shot Image Editing
and Printing
Shooting di information < ! > .
y - o [ Shooting distance information Processing
o slider*2 (p.68) Large Numbers
h— ' of Images
5 i ’""m'mm: | Peripheral illumination correction
| Chromatic aberration = Edltlng
- }— Chromatic aberration correction ‘"TEG’T IFF
mages

@ 100
() ' U }——— Corrects blue chromatic aberration

Color blur correction

[ Color blur |

_J

e oo }— Distortion correction Reference
Ol
Shows/hides position of “
] Mavigator ) enlargement display section
{_ | Grid

00

Enlargement display position Corrects red chromatic Grid display
(Navigator display) aberration @
*1 The area you clicked on the image (Enlargement display position) is *2 For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF

displayed at 200%. 50mm /2.5 Compact Macro with Life Size Converter EF, the slider

indicator changes to the zoom magnification. 136



List of Digital Lens Optimizer Adjustment Window Functions (p.69) s

Enlargement display position (Navigator display)

Shooting distance slider (p.72)

34

Digital Lens Optimizer adjustment (p.72)

iif

Reference

Enlargement display section*’

*1 The area you clicked on the image being enlarged (Enlargement display position) is displayed at 100%.

o
S
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List of Compositing Tool Window Functions .75

|| IMG_0001.CR2 [3456 x 2304]

.

100% view ——
| IMG_0002.CR2 —

hted

— 100% display (p.79)

— Select foreground image (p.79)

—— Thumbnail display for foreground
image (p.79)

- Select composite method (p.79)

— Use RAW compositing (p.80)

Weighting slider (p.79)

Alignment controls (p.80)

—— Continue compositing (p.81)

Continue —
( Save As... :j

J
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List of HDR Window (Adjust Image) Functions (1) s ,ntmductionl

Contents at
a Glance

Prasets Basic
rrmw— Select an effect (p.83) Operation I

Advanced
Operation

anea Adjust Image

Adjust tone/color (p.83) Advanced

Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
Adjust detail emphasis (p.83) JITEEQI’LEF
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List of Copy Stamp Window Functions .73t p.77,

[# 1/2 IMG_0050.CR2 [3456 x 2304]

[ 100% view I [ Full size ;ie\n:}—

[ Apply Dust Delete Data %—
(Light) (Dark) )

{ [ |
OO @O B
Select Copy Source =

_ Fix Copy Source position ——
Pen type
=) Brush

dius

 Pencil ]

Set to 100% View to perform stamp operation. ;j

* Operates when you have selected multiple images and the copy
stamp window is displayed.

p-114 to p.118)

— Full screen display/returns to normal screen
— Applies Dust Delete Data (p.73, p.114)

— Types of dust to be erased (p.75, p.116)

- Specifies the copy source (p.77, p.118)

— Fixes the copy source position (p.77, p.118)
— Types of stamps (p.77, p.118)

Sets the size of the dust erasure range (p.75,

- —p.116) or copy range (p.77, p.118) in a range of

510 100 (in one pixel units) (you can also enter
a numerical value)

\— Restores/redoes the image

Copies the dust erasure range or copy range and
applies (pastes) it to another image

Switches between displayed images*

}
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List of Convert/Save Multiple Images Window (Batch Processing) Functions (0.99)

File names of images to be

batch saved

Types of image

| TS,
IMG_0001.CR2

IMG_0002.CR2
IMG_0003.CR2
IMG_0004.CR2
IMG_0005.CR2
IMG_0006.CR2
IMG_0007.CR2
IMG_0008B.CR2
IMG_0009.CR2
IMG_0010.CR2
IMG_C0011.CR2
IMG_0012.CR2
IMG_0013.CR2
IMG_0014.CR2
IMG_0015.CR2

 S——————

Batch settings

MacOSX /Users /canon/Documents

[ Save folder

ST J» Save destination
Browse... )

© w—+— JPEG compression rate*3

Resolution*1

— Embeds ICC profiles*2 (p.143)

Size changing*4

File format
Hl(ind of file | Exif-JPEC | :D
Image quality :‘
Qutput setting
Output resalution 350 dpi [ Embed ICC praofile
(" Resize setting A
| Resize
Width Height Unit
3456 x 2304
{ 3456 pixel ) {2304 pixel ) =
v
\. = J/
( File name )

Type of image Extension
Exif-JPEG JPG
Exif-TIFF 8bit .TIF
TIFF 16bit TIF

Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG

TIFF 16bit+Exif-JPEG | .TIF/.JPG

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.77, p.93) information that is set in an image is attached

to an ICC profile.

Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.77,

" Current file name
String

¥} New file name

.

String Sequence number
opP_ o001
Ex.: DPP_0O0L.JPC, DPP_OCOZ.JPC

! Save sequence number

File name

r_l_[rlage transfer settings
__ Open image using software

\L

! Batch transfer to other image
) | editing software (p.100)

Browse...

’ Convert RAW images only ‘ |

Cancel \ (

Execute }

Images to be converted are limited to RAW images*>

p.93), the ICC profiles are embedded automatically.

Save

*3 The setting range is 1 to 10. The higher the numerical value, the higher

the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the

longer edge of an image and change its size.
*5 Appears when you click the [Batch process] button (p.124, p.133)

without an image selected in the main window or the edit image
window. To convert RAW images only, instead of clicking the [Execute]
button, click this button.
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List of Rename Window Functions .101)

Introduction

—_—

MacOSX /Users/canon/Pictures /Photo/ 3o _xx_xx

Contents at

(" File Name Extension R S h f| a Glance
DPP EI Shooting Date/Time E] Seguence number :j Do not change E] ets the new file name —
& J
( Basic Settings \ ( Format settings h
. ) ) Sort Sequence number o Bas'?
Order in which Images are sorted %) Fit to main window 0001 _| Save sequence number peration
) File Name
_ shooting Date/Time Shooting Date Time . .
— d Sets the format of information
Check mark to apply the same ———H ¥ ©oie i e o i i e ) Month Day Year ") in the file name Advanced
name to RAW images and JPEG ( __ Copy & Rename ~ Browse.. ) MM-DD-YY 3 Operatlon
ImageS recorded s|mu|tane0us|y MacOSX/Users/canon Desktop Elnser‘t underbar
Check mark to copy the images L J Advanced
Click the [Browse] button and set Original File Modified File Name I?:g%ﬁg;.t%g
the save destination IMG_0001.CR2 DPP_09-13-06_0001.CR2
IMG_0001.JPG U DPP_09-13-06_0002.JPC U
IMG_0002.CR2 ;DPF_09—13—05_0003.CR2 Processing
- Large Numbers
I " NS, SR of Images
IMG_0003 JPG — |DPP_09-13-06_0006.JPG
IMG_0004.CRZ EDPP_OQ—IZ—UG_UDD?.CRZ
IMG_0004. PG DPP_09-12-06_0008.JPC Editing
IMG_0005.CR2 \DPP_09-13-06_0009.CR2
IMG_0005 JPG . |DPP_09-13-06_0010.1PG = JPEG/TIFF
€ — e I [(— ) Al | Images
( Cancel ) € Execute)
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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Color space

A color space is the reproducible color range (color gamut
characteristics). DPP supports the following five kinds of color space.

sRGB : Standard color space for Windows. Widely used for
the standard color space of monitors, digital
cameras, and scanners.

Adobe RGB : A wider color space than sRGB. Mainly used for
printing for business purposes.

Apple RGB : Standard color space for Macintosh. A slightly

wider color space than sRGB.

ColorMatch RGB : A slightly wider color space than sRGB. Mainly
used for printing for business purposes.

Wide Gamut RGB : A wider color space than Adobe RGB.

Refer to the color chart below for the color area of each color space.

Color chart of color spaces compatible with DPP

y

Color range that can be
seen by the human eye

Gamma White point

value (color temp.)

—— | sRGB 2.2 6500K(D65)
————-- Adobe RGB 2.2 6500K(D65)
............ Apple RGB 1.8 6500K(D65)
————— ColorMatch RGB 1.8 5000K(D50)
—————— Wide Gamut RGB 2.2 5000K(D50)

CMYK simulation profiles

A profile that simulates colors when printing in a CMYK environment
(printing machine, etc.). With DPP, you can simulate color with four

types of profile.

Euro Standard :

JMPA :

U.S.Web Coated :

Profile normally used for book printing in
Europe, suitable for simulation of standard
European printing.

Profile normally used for book printing, etc. in
Japan, suitable for simulation of magazine
advertising standard color printing.

Profile normally used for book printing in
North America, suitable for simulation of
North American standard printing.

JapanColor2001 type3 : Profile becoming a standard in the Japanese

printing industry, suitable for simulation of
JapanColor standard printing.

Rendering intent

Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below.

Perceptual :

Relative Colorimetric :

Before and after conversion, all colors are
converted to maintain the relationship between
colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However,
depending on the image, the saturation may
change overall.

There will not be much conversion to colors
which are similar before and after conversion,
but colors which are not similar are converted
appropriately. Because there are little changes
to similar colors which comprise most of an
image, you can print a natural-looking image in
which the saturation has not changed greatly.
However, depending on the image, there are
cases where the overall tone of an image
changes somewhat as colors which are not
similar and highlights change.
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Index

A

AdJUuSt JPEG IMAQgES.....coviiiiiiiiiiiiiiiieee e 103

Adjust RAW IMages ... .. 25

AdJuSt TIFF IMages......ccoviiiiiiiiiieeeee e 103

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve Assist)............cccceeeeee. 104
BrightneSsS ..o 105
Click White BalanCe ..........coooiiiuiiiiiiieeiieeeee e 106
(O] ] 1= RSOOSR 105
DynamiCc Range.........uuuiiiiiiiiieiee e 109
HUG e 107
RGB ToOl Palette .......cccoeviiiiiiiiiiee e 128
Saturation ... 107
SNAIPNESS ... e 107
Tone Curve Adjustment...... ..o 108

Adjusting (RAW image)
Apply Adjustments.............eoiiiii s 97
Automatic Adjustment (Tone Curve ASSISt).......cccccceeeeiiiiciiieennnn. 33
BrIghtNess .....eeeieiiiieee e 26
Brightness of Highlights.............cooii e 57
Brightness of Shadows.............coiiiii 57
Click White BalanCe ...........ccuuuuiiiiiiiiiiiiiiiiieeeeneaee 28
Color Saturation ..........cccocoiciiiieii 29
Color TEMPErature ........oooiiiiiiieiiee e 56
(0701 (o] gl o] o [T 29
COlOr WNEE ... 56
(O] 1= 1S SRR 29
Copy AJUSTMENTS ......uuiiiiiiiiiiiiiiiie e eraeeaaeeeeees 97
DynamiC RANGE .......ooooiiiiiiiiii e 57
Filter EffeCt ... 30
MONOCAIOME ... 30
Personal White BalancCe ..., 98
Picture Style ... 26
Picture Style File ........ooooiiii 59
RAW Tool Palette..........uuuueiiiiiiiiiiiiiiieieieeeeeeeeeeeeeeeeeeeee e 128
Save AdJUSTMENTS ......uueiii 97
Tone Curve Adjustment...........cccoii s 58
Toning EffeCt ... 30
B Yo I = 1<) £ (=TT 128, 129
White BalancCe ... 27

Adjustment Contents (ReCIPE)......cccevviiiuiiiiiiiiiiiiiiiiieeeeee e 96, 143
AdODE RGB ... 144
F Y o] o LT R {1 = TP 144
AIrange IMaAgES .....uvvuiei i e e e e eeeaees 20, 21
Auto Lighting Optimizer ... 61
Automatic Adjustment (Tone Curve AsSist)...........eevveveevvveveeeenee. 33, 104
Automatic Dust Erasure Processing.......ccccccvvveveeeveeeeen. 73,74,114, 115
B
Batch Apply White Balance to Images (Personal White Balance)....... 98
Batch Change the File Name of Images.........ccccccoviiiiiiiiiiiiiiiiine, 101
Batch Convert/Save Images (Batch Process) .........ccvvvvvveevieeiieiiinnnnnn. 99
Batch Process (Batch Save JPEG and TIFF Images)................. 99, 141
Batch Process of Multiple Images
Change File Name ... 101
Convert/Save (Batch Process)........cccouucuvvvveeiiiiiiiiiiiiiieeeeenn 99, 141
Personal White Balance.........cccccccvvvveeviiiiiiiiiiiieeeeeee 98
Recipe Data .....ccooooviiiiiiiiiiiii 96
L= 10 = SRR 100
Batch Settings Window...........cccccoeiiiiiiiiiiiiiiinns 99, 100, 141
Batch Transfer Images ... 100
Batch Transfer Images to Image Editing Software..............cccccvvvvene. 100
Before/After Comparison Display ...............eueeieiiiiiiiiiiiiiiiiiiiieeeeeeeeeeee 53
DIt NUMIDET ... 143
BOOKMAIK ... 51
BrightnNeSS. ..o 26, 105
C
Change File Name............cccoe o, 101
Changing the File Name of Images in the Order in the Main
WINAOW ..t eeeeeeans 101
CheCK Mark .......cooiiiiiiiiiie e 18, 19, 126, 132
Chromatic Aberration Correction...........ccooeeiiiiiiiiiciicc s 65
Chrominance Noise Reduction (JPEG, TIFF Images).........ccccccuuuu.e. 110
Chrominance Noise Reduction (RAW Images) ..........ccccuveeeeeeiiiiiinnnen. 62
Click White BalanCe.........oeeeeieeeeeeee e 28, 106
CMYK SIMUIALION ... 93, 94, 144
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Collection WINAOW .......cuueiiieiiieeiee e 6, 36, 125
(O70] o] g =1 1] gl @7 o] 5 =Tex 1 o] o HF PSPPSR 65
Color Chart......cooeieiieeeeeeeeee e 144
Color Management (Color Matching)...........ccccoeeeieiie, 143

Color Setting of the Monitor (Profiles) ..........cccccoiiiiiiie. 93

Color Setting of the Printer (Profiles)..........cccccciiiiiiiiiennnn. 93, 94

(0] (o] RS o7 To? = T 144

ICC ProfileS ..cooovvveeeiiee 143
Color Management (Preferences)..........ccocvviiiiiiiiiieiiiiiiiieeeeee e 93
COolor SAtUratioN .....ccee e 29
Color Setting of the Monitor (Profiles)...........oooiiiiiiiiiies 93
Color Setting of the Printer (Profiles) ......................cl. 93, 94
COlOr SPACE ... 144

AdODE RGB ... 144

APPIE RGB ... 144

Color Space Setting for Each Image ...........ccccoviiiiiiiieiiiie 77

ColorMatch RGB ...........uuuiiiiiiiiiiiiiieiiiiiieeeeeeeeeee e 144

Default Setting of Color Space ..........ccccvveveviiiiiiii e 93

SRGB ... .. 144

Wide Gamut RGB...........c.ouviiiiiiciiee e 144
Color Space Setting for Each Image..................cccc, 77
Color Temperature...........oooovioiiieeie 56
(O70] o] g 1o 1= TSP 29
Color Wheel ..o 56
ColorMatch RGB........cooeeee e 144
Compatible Cameras with the Lens Aberration Correction Function.. 63
Compatible Lenses with the Lens Aberration Correction Function..... 63
Compositing IMagES ........uviiiiiiii e 78
Contact Sheet Printing (Printing a Thumbnail List)............................ 86
(070] 011 = 1) (T 29, 105
Convert to JPEG or TIFF Image and Save................... 42,99, 134, 141
Convert/save One Image Window ..., 42,134
Copy Stamp (Image Correction) ..., 77,118
Copy Stamp WIindow ... 73,75, 114, 116, 140
Copying and Pasting (Applying) Recipes...........cccccceieiiiie, 97
Correct Images (Copy Stamp Function) ...........ccccceveiiiniiiiinnn. 77,118
Creatinga Folder ... 50

D

Default Noise Reduction Settings............ooooiiiiiiiiiiiiiii 92
Default Setting of Color SPace ........ccccccuvuuiveiiiiiiiiiiiiiieereee e 93
Delete IMages .....coooiiiiiiieee e 49
Deleting

Delete IMAagesS ......eeiiiiiiiiie s 49

Delete the Software .............oeeviiiiiiiii e 123
Deleting DPP (Uninstalling) .........cccooiiiiiiiiiicciis 123
Detailed Setting Printing (Printing with Shooting Information)............. 85
Digital Lens OPtimizZEer ............uiiuiiiiiiiiiiiiiiiiiiiiieiseveeveeesseessreeeeeeeeeaee 69
Display

Before/After Comparison Display...........cccccovevviii 53

Enlarged Display (Edit Window) ........cccccccvviiiiiiiiiini 11, 127

Enlarged Display (Quick Check Window) ..........cccccceeeeeennnns 16, 132

Shooting Information Display ...........cceveeviieiiiiiiiiiiiiiieiiieeeeeee, 10, 23

Single IMmage DiSplay ............eueeeiiiiiieiiieeiieieeeeeeeeeeeeeee e 22

Synchronize Edit WiNdOW ............coooiiiiiieee e 54

Thumbnail Display (Main Window).............ccccviiieeiiiinnninnee. 10, 124

Thumbnail Display and Enlarged Display

(Edit Image WindOoW)........ccoiiiiiiiieeiiieeeee e 34, 133
Distortion CorreCtion.........cccoooiiioiicc s 65
Downloading an Image to Your COMPULET .............uuvveivverinniiiriiiiiinnninnns 7

Downloading Images from a Camera ...........cccouvieeeeeiiiiiiiiiieeeeen 7

Downloading Images from a Card Reader...........................ooooe. 9
Downloading IMages .......ccouvuiiciiii e 7
Downloading Images from a Camera...........ccccceeeeeiiiiiiiiieeeceeeeee 7
Downloading Images from a Card Reader .............ccccuvvvvvvvnvvvvininiinnnnnnn,
Dust Delete Data ............coooiiiiiiiiiiie
Dust Erasure Processing

Automatic Dust Erasure Processing ...........cccveeeeeeeiniiiiinnnnn.

Image Correction (Copy Stamp Function)

Manual Dust Erasure (Repair Function) ............ccccveeeeeeinnns 75,116
Dynamic Range ........coooiiiii 57,109
E
Edit Image WindOW........ccooviiiiiiiiee it e e ee e 34,133
Edit WINAOW... ...t 11,127
o 111 g o TSROSO —>Adjusting
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Enlarged Display (Edit WiNdOW) ..........cccuiiiiiiiiiiiiiiieeeee s 11,127
Enlarged Display (Quick Check WiNndOw) ..........ccoooiiiiiiieieeeeiniiieeee. 132
EOS Uy ..o 7
F
False Color REAUCHION .. .c.uieeeeee e 89, 90
Filter Effect.......cooii i 30
[=T0] (o 1Y g VAVA o o [0,V AN TP 6, 124
G
General Settings (Preferences) ... 89
H
HDR (High Dynamic Range) Images...........ccccoviiiiiiiiiiiiieiiiiiieeeeenn 81
L= TP Cover
Highlight Area Warning Indicator ..o 55
HUE .o 107
|
(O O {0 11 P 143
Image Frame Information (Image Marks) ..........cccceveeveeeeieeeieeeeeeeeen. 126
Image Marks (Image Frame Information) ...........ccocoviiiiiiiiininiiinnn. 126
Image Quality
Default Noise Reduction Settings...........cccccceiiiiiiiiiie 92
False Color Reduction..........coeooviuiiiieeieee e 89, 90
Improve the Quality of an Image (Main Window) ............cccueeeee. 23

Noise Reduction of a JPEG Image (Luminance, Chrominance) 110
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 62

View and Save a RAW Image...........ccccooee 89, 90
Image Shooting Information Display ..............eeeeeeveevieeeiieieeieieeneeee. 10, 23
Improve the Quality of an Image (Main Window)..........cccccoviiiiennnnn. 23
J
| = 4 4= To [T PP PPPRPPP 143
L
Lens Aberration CorreCtion ...........ooovvvueeeiiieeeeeeeeeee e 63
Lens Aberration Correction Window ...........ccooovviiiiiiiiiiiiieieeeinns 65, 136
LENS TOOI Palette ......ccooeeeeeeeeeee e 130
[T 1= | SRS 29

Loading and Pasting (Applying) RecCipes........ccccoeeiiiiiiiiiiiiiiic, 97

Luminance Noise Reduction (JPEG, TIFF Images) ..........cccceeuuvnnen. 110
Luminance Noise Reduction (RAW IMages)........cccvvvvvvvrvverireeeeeeeennnee. 62
M
MaIN WINAOW ... e e e 10, 124
Manual Dust Erasure (Repair Function)...........ccccccvvvvvivvviveeenneee. 75, 116
MAP UBIHIEY . 84
MONOCHIOME ...ttt eeeeeeee 30
Filter EffeCt.. ..o 30
ToniNg EffeCt ... 30
Move Or COPY FOIErS ......coooiiiiiiiiiiiiiee e 51
Move or COPY IMAGES ......uuuuuiiiiiiiiiiiiiiiiiiiiiiiitiirereresreereeeereeesreeeeeeeeeeees 50
N
Noise Reduction (JPEG or TIFF Image)........ccccccevuereeirnerinneniniiininnnns 110
Noise Reduction (RAW IMage) ........cccooriiiiiiiiiiiiiiiiieeeeeee e 62
Noise Reduction of a JPEG Image (Luminance, Chrominance) ....... 110
Noise Reduction of a RAW Image (Luminance, Chrominance) .......... 62
NR Preview WIiNAOW.........coooiiiiiiiiiiieeeeeeeee e 62, 110, 131
NR/ALO ToOl Palette ......ccoveeiiiiieieeee e 129
(0]
Organize IMages ..o 49
Organizing IMagESs ........uuuiiiiiiiiiiiiie e 49
Create @ FOIder.........uuiiiiieeeeeeee e 50
Delete IMagesS......ccovvieeeece e 49
Move or Copy Folders.........ccccoiiiiiii 51
Move or Copy IMages........oovvviiiiiiiieeee 50
Register Folders as Bookmarks............cccccoiiiiiiiiiieeiiieeen 51
P
Peripheral lllumination Correction .............cccccvvvviivviiiieeeiiiiiiieeeeeeeeeeee, 65
Personal White Balance .............ccccuuuiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeeee 98
PiICture SEYIE ..o 26
Picture Style File......ccooiiii e 59
Prefer@nCes ... . 89
(0] (ol Y/ F=TaT=To [T 1 1T o | AU PP 93
General SettiNGS . ..vvveiiiiei e 89
Tool Palette ... 92
VieW Settings ..oooooeiieee e 91
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Printing
Printing a Thumbnail List (Contact Sheet Printing) ..................... 86
Printing One Sheet of Paper ..., 14, 49
Printing Using Easy-PhotoPrint...........ccccviiiii e 46
Printing Using Easy-PhotoPrint EX ..., 43
Printing with a High-End Canon Printer....................................... 87
Printing with a Large-Format Canon Printer.............cccccccoiiinnne. 88
Printing with a Printer other than Canon Printers ......................... 49
Printing with Canon Inkjet Printers ...........ccccccooiiiiiiis 43, 46
Printing with Easy-PhotoPrint Pro .........ccccocc, 87
Printing with Shooting Information (Detailed Setting Printing)...... 85
Rendering Intents when Using Easy-PhotoPrint .................... 93, 94
Printing a Thumbnail List (Contact Sheet Printing)...........ccccccccvunnnnn. 86
Printing One Sheet of Paper...........oooooiioii oo, 14, 49
Printing Using Easy-PhotoPrint...........cccccooviiiriiicc e, 46
Printing Using Easy-PhotoPrint EX..........oooi 43
Printing with a High-End Canon Printer...........cccooooiiiiiiiiiiiiccccc, 87
Printing with a Large-Format Canon Printer ............cccciiiiinninnnee. 88
Printing with a Printer other than Canon Printers..............ccccccccinnnnne. 49
Printing with Canon Inkjet Printers............cccciiviies 43, 46
Printing with Easy-PhotoPrint Pro..........cccoovviiiiiccce e 87
Printing with Shooting Information (Detailed Setting Printing) ............ 85
Q
Quick Check WINAOW........ccoiiiiiiiiiiiiceee e 16, 132
QUILEING DPP .. 14
R
RALING. .. 18, 19, 132
RAW IMAGE.....eeeeiiiiiiiieiee et 143
RAW ToOl Palette ...........ooeeiieiiiiiieeeee e 128
Re-Adjusting an Image ..o 43, 120
RECIPE ... 96, 143
ReCIPE File ..o, 96
Re-Editingan Image ..........ccooiiiiiiiicccc e, 43,120
Registering Folders as BooKmMarks ...........ooooouviiiiiiiiiiiiiiiiieceeeee s 51
ReNaME WINAOW ... ...t 101, 142
Rendering Intent (Matching Method) ... 144

Rendering Intents when Using Easy-PhotoPrint..................... 93, 94
Rendering Intents when Using Easy-PhotoPrint ...............ccc..... 93, 94
Repair (Manual Dust Erasure)..........cccccvvvvvvvviivinviieiiiineeeeeeeeeeeeeee, 75, 116
RGB Tool Palette. .. ..o 128
Rotate Images ......cccoovvvvviiiiiiiiciie e, 10, 25, 124, 125, 132, 133
S
Saturation ......ooooviii 107
Save

Batch Convert/Save Images (Batch Process)..........cccccoo... 99, 141

Convert to JPEG or TIFF Images and Save. ..........ccccuuu...... 42,134

S AV B . s 41,119

SAVE Ao 41, 119

Save JPEG or TIFF Image as a Separate Image ...................... 119

View and Save RAW ImMages.......ccccooeiiiiiiiiiiiiccnias 89, 90
S AV A oo 41,119
SAVING RECIPES...ceiiiiiiiititeie e e e 97
Select IMmages........oooi 10, 16, 34
Shadow Area Warning Indicator ... 55
SharPNESS ..o 31, 107
Shooting Information Display..........ccc.eeeiiieiiiiiiiii e 10, 23
ShOMCUL KEYS ..., Cover
Single Image Display ...........ccooiiiiiiiiie e 22
Single Image Display of RAW and JPEG Image.........cccceeeiiiiiiinnnnnn, 22
Sorting Images

CRECK MAIKS .o 18, 19

= 1 1] o 1= P 18, 19
SRGB ...t aaa s 144
Starting UP DPP ..., 6
Supported IMages ..o 3
Synchronization (Edit Window)...........coooooiiiiiiii e, 54
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Macintosh is a trademark of Apple Inc., registered in the United States
and other countries.

Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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